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1
Introduction to CANopen Configuration Studio for
IXXAT CME/PN

CANopen Configuration Studio for IXXAT CME/PN is an easy to use tool that supports generation of configuration
data for the IXXAT CME/PN PROFINET RT to CANopen gateway from IXXAT Automation GmbH. The IXXAT CME/PN is
a powerful and easily configurable gateway for connecting CANopen devices and networks to PROFINET systems.

The IXXAT CME/PN converts PROFINET RT frames to CANopen frames and vice versa. On the PROFINET side it
features a built-in 2-port switch. On the CANopen side up to 120 CANopen devices can be connected. Detailed
hardware information is included in IXXAT CME/PN hardware manual.

The IXXAT CME/PN is configured via USB interface or remote via Ethernet. When configured it acts as customer-
specific PROFINET IO device and as CANopen manager with functionality according to CiA 301 and CiA 302. The
IXXAT CME/PN maps PROFINET slots to CANopen network variables. It supports a wide range of applications from
short cycle times with few variables up to longer cycle times with a large number of variables.

CANopen is an internationally standardized (EN 50325-4) CAN based higher-layer protocol for embedded systems. In
addition to the application layer and communication profile specified in CiA 301, the version of EN 50325-4 which is
maintained by CAN in Automation (CiA), the set of CANopen specifications also covers device (CiA 401, CiA 402, CiA
404, CiA 406), application, and interface profiles. CANopen supports extensive configuration capabilities.

A CANopen network is commonly composed of several CANopen slave devices and one dedicated device acting as a
network management (NMT) master. The NMT master is responsible for starting the CANopen slave devices. A NMT
master that additionally supports configuration manager functionality is called CANopen manager (CiA 302-1). If the
CANopen manager is integrated with a PLC runtime system, process data of the CANopen slaves are mapped into a
process image on the manager. CANopen Configuration Studio for IXXAT CME/PN fully supports parameterization of
the NMT master, the configuration manager, and the process image description.

In the example shown the figure below, one IXXAT CME/PN gateway operates as CANopen manager and a SIMATIC
S7-300 PLC is used as PROFINET IO controller. Alternatively other PROFINET IO controllers may be deployed instead.
Additional I/O modules and servo drives complete the example network. The node-IDs in the figure below have been
chosen arbitrarily, but will be used in the examples contained in later sections of this documentation.
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Supported Functionality

Selection of CANopen manager and CANopen slave devices based on a user configurable device catalog.
Management of any number of device description files inside the device catalog.
Configuration of CANopen manager parameters including NMT startup object, NMT slave assignment, and
device type identifications.
Configuration of NMT error control services, both heartbeat and node guarding.
Direct configuration of device parameter objects which are written to the CANopen devices on network startup.
Individual selection of application objects to be mapped into the process image of the CANopen manager.
Alternatively, selection of application objects based on default PDO mapping of CANopen slave devices.
Automated calculation of PDO communication and mapping parameters for both CANopen manager and
CANopen slave devices.
Manual manipulation of PDO communication and mapping parameter for CANopen slave devices.
Inspection of the calculated process image and grouping of parameters within the process image.
Manual adjustment of PROFINET timing parameters with estimation of the resulting CANopen bus load
Generation of concise device description data and direct download of network configuration data to the IXXAT
CME/PN.

The IXXAT CME/PN shall be solely configured by CANopen Configuration Studio for IXXAT CME/PN. The
configuration process generates customer-specific concise DCF and GSDML files. Use only these generated
concise DCF and GSDML files to configure the IXXAT CME/PN. Do not change the configuration in the object
dictionary via SDOs because this will invalidate the configuration.

The IXXAT CME/PN maps PROFINET slots to CANopen network variables. Note that PROFINET guarantees that
the data in one subslot are consistent. The mutual consistency of data in two different subslots cannot be
guaranteed. If it is vital that all data of one CAN message appear consistently on PROFINET you must map all
data of one CAN message to one network variable with appropriate size e. g. UNSIGNED64.

The IXXAT CME/PN acts as CANopen manager. Note that the CANopen manager does not support the optional
Layer Setting Service (LSS).

This documentation assumes that the reader is familiar with CANopen communication technology and has
access to the most recent CANopen specifications.

CANopen Configuration Studio for IXXAT CME/PN 5
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2 Important User Information

Liability
Every care has been taken in the preparation of this manual. Please inform IXXAT Automation GmbH of any
inaccuracies or omissions. The data and illustrations found in this document are not binding. We, IXXAT Automation
GmbH, reserve the right to modify our products in line with our policy of continuous product development. The
information in this document is subject to change without notice and should not be considered as a commitment by
IXXAT Automation GmbH. IXXAT Automation GmbH assumes no responsibility for any errors that may appear in this
document.

There are many applications of this product. Those responsible for the use of this device must ensure that all the
necessary steps have been taken to verify that the applications meets all performance and safety requirements
including any applicable laws, regulations, codes, and standards

IXXAT Automation GmbH will under no circumstances assume liability or responsibility for any problems that may
arise as a result from the use of undocumented features, timing, or functional side effects found outside the
documented scope of this product. The effects caused by any direct or indirect use of such aspects of the product are
undefined, and may include e.g. compatibility issues and stability issues.

The examples and illustrations in this document are included solely for illustrative purposes. Because of the many
variables and requirements associated with any particular implementation, IXXAT Automation GmbH cannot assume
responsibility for actual use based on these examples and illustrations.

Intellectual Property Rights
IXXAT Automation GmbH has intellectual property rights relating to technology embodied in the product described in
this document. These intellectual property rights may include patents and pending patent applications in the US and
other countries.

Trademark Acknowledgements
Anybus® is a registered trademark of HMS Industrial Networks AB.

CiA® and CANopen® are registered Community Trademarks of CAN in Automation e.V.

IXXAT® is a registered trademark of IXXAT Automation GmbH.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.

SIMATIC® and S7-300® are registered trademarks of Siemens AG.

All other trademarks are the property of their respective holders.
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3 System Requirements
To operate CANopen Configuration Studio for IXXAT CME/PN the following system configuration is recommended:

x86/x64 CPU with 1.8GHz or higher
2GB RAM
20MB available space on hard disk
1024x768 display (1280x1024 recommended)
Microsoft® Windows® operating system, (Windows XP SP3, Windows Vista®, Windows 7, Windows 8)
Microsoft® .NET® Framework 4 Full
PROFINET engineering tool

3.1 Installation and First Steps
The installation procedure installs CANopen Configuration Studio for IXXAT CME/PN by default into the
%ProgramFiles%\IXXAT Automation GmbH\CANopen Configuration Studio for IXXAT CME-PN
directory. The Microsoft Windows environment variable %ProgramFiles% is typically set to C:\Program Files on
US locale systems or C:\Programme on German locale systems.

The installation procedure installs the configuration tool and the USB driver.

Execute the installation procedure on the PC before connecting the IXXAT CME/PN via USB.

Do not connect the USB plug to an unpowered IXXAT CME/PN device. Supply the IXXAT CME/PN power first
and mate the USB plug next. Otherwise the device may be subject to irreparable damage.

The installation procedure installs the command-line tool USBErrorLog.exe to the PC. If a fatal error is
indicated by the IXXAT CME/PN LEDs (see hardware manual) the user can read an error log via USB that
supports error trace back. Note that reading the error log aborts the network communication.

The default location for project files is typically set to C:\Users\Public\Documents\IXXAT\CANopen
Configuration Studio for IXXAT CME-PN on Microsoft Windows 7 systems and to C:\Documents and
Settings\All Users\documents\IXXAT\CANopen Configuration Studio for IXXAT CME-PN on
Microsoft Windows XP systems. The exact path depends on the operating system locale.

To start CANopen Configuration Studio for IXXAT CME/PN open the Microsoft Windows start menu and
navigate to All Programs\IXXAT\CANopen Configuration Studio for IXXAT CME-PN \.

CANopen Configuration Studio for IXXAT CME/PN 7

©2015 IXXAT Automation GmbH. All Rights Reserved.



4 User Interface
The initial user interface layout of the CANopen Configuration Studio for IXXAT CME/PN main application window is
shown below. The design of the user interface is similar to typical development environments, allowing for a quick
familiarization with the application. Main elements of the user interface are tool windows for network definition and
device specific configuration tasks and a central workspace within which most of the CANopen manager and network
configuration is performed.

The user interface layout is fully customizable but may be restored to its default settings at any time.

CANopen Configuration Studio for IXXAT CME/PN main application window

8 CANopen Configuration Studio for IXXAT CME/PN
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The main application window of CANopen Configuration Studio for IXXAT CME/PN is subdivided into the following
main regions:

Menu system and toolbars.

CANopen network topology definition and device catalog browser.

Main workspace for CANopen manager configuration. Contains windows and controls for parameterization
of NMT startup and NMT slave assignment objects (see CiA 302-2), NMT error control, and to select
application objects to be mapped into the process image on the CANopen manager. The timing parameters
page allows to configure both PROFINET cycle time and CANopen bit timing parameters.

Device specific parameterization tool windows. Supports additional PDO configuration. Also gives access to
all device parameters that are not related to the configuration tasks performed in the main workspace
windows.

Output tool windows containing error, warning, and status messages.

4.1 Menu System and Toolbars
The menu system and the toolbars contain a set of menu items with commands required to generate new projects,
calculate I/O connections, generate and download configuration data. The menu system supports navigation via
mouse pointer, keyboard shortcuts and accelerators or the cursor. For a complete list of the menu system see the
tables below.

Main Menu

Standard Toolbar

Build Toolbar

Network Toolbar

CANopen Configuration Studio for IXXAT CME/PN 9
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Menu Description

File (keyboard accelerator: Alt+F)

The File menu contains commands related to the CANopen project (new, open, and close project, and save project
with different name).

Icon Command Keyboard shortcut Keyboard accelerator

New Ctrl+N Alt+F, N

Open Ctrl+O Alt+F, O

Close

Save As Alt+F, A

Recent Projects Alt+F, R

Exit Alt+F, x

View (keyboard accelerator: Alt+V)

Commands for activating tool windows or workspace pages. Additionally a menu item allowing to restore the default
tool window and workspace layout is available.

Icon Command Keyboard shortcut Keyboard accelerator

Network Management Configuration Alt+V, N

Error Control Configuration Alt+V, E

Application Objects Alt+V, A

Process Image Alt+V, P

Timing Parameters Alt+V, T

Error List Alt+V, L

Output Alt+V, O

Project Explorer Alt+V, x

Device Catalog Alt+V, D

Device Parameters Alt+V, P

PDO Parameters Alt+V, P

Restore Default Layout Alt+V, R

Project (keyboard accelerator: Alt+P)

Contains only one menu item that opens the project properties workspace page.

Icon Command Keyboard shortcut Keyboard accelerator

Properties Alt+P, P

10 CANopen Configuration Studio for IXXAT CME/PN

©2015 IXXAT Automation GmbH. All Rights Reserved.



Build (keyboard accelerator: Alt+B)

The Build menu contains commands to calculate PDO connections and device specific configuration data. The
calculation process can be repeated iteratively before a file with the configuration data is generated that shall be
downloaded to the IXXAT CME/PN.

Icon Command Keyboard shortcut Keyboard accelerator

Calculate Configuration F5 Alt+B, C

Generate Configuration F6 Alt+B, G

Network (keyboard accelerator: Alt+N)

Pop-up menu containing commands to select and configure the download link to the IXXAT CME/PN. A dialog allows
to select any one of the IXXAT CME/PN gateway devices connected via USB to the host PC running CANopen
Configuration Studio for IXXAT CME/PN.

Icon Command Keyboard shortcut Keyboard accelerator

Interface Configuration Alt+N, C

Download F7 Alt+N, D

Tools (keyboard accelerator: Alt+T)

The Tools menu contains commands to open the device catalog management dialog and to set general options of
CANopen Configuration Studio for IXXAT CME/PN.

Icon Command Keyboard shortcut Keyboard accelerator

Manage Catalog Alt+T, M

Options Alt+T, O

Help (keyboard accelerator: Alt+H)

The Help menu gives access to online documentation. The technical support menu item contains a link to the support
section on http://www.ixxat.com/.

Icon Command Keyboard shortcut Keyboard accelerator

View Help Alt+H, V

Technical Support Alt+H, T

About CANopen Configuration Studio for IXXAT
CME/PN
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4.2 Tool Windows
CANopen Configuration Studio for IXXAT CME/PN implements tool windows for network definition and device
specific configuration tasks. Tool windows are used to compose a CANopen network based on predefined entries in a
device catalog. Tool windows are also available to set device specific parameters such as default values for output
parameters, or to explicitly manipulate the PDO configuration for a selected device. Additionally output and error
windows are available to inform the user on the result of a configuration calculation or errors occurred during the
calculation.

For detailed information on the tool windows see the following sections:

Icon Name Description

Project Explorer Definition of CANopen devices available in the network.

Device Catalog Pre-configured catalog of CANopen devices.

PDO Parameters Explicit configuration of PDO communication and mapping parameters.

Device Parameters Direct configuration of device parameter that are not configured by either the
PDO parameters tool window or via the automated calculation of
configuration data based on the workspace tab page input settings.

Output Tool window containing textual status and error information generated by
CANopen Configuration Studio for IXXAT CME/PN. By default auto-hide is
enabled and the window is in hidden state at the bottom of the main
application window. The Output tool window will become visible as soon as
CANopen Configuration Studio generates new output information.

Error List The information in the Error List tool window is identical to the Output tool
window, however the Error List tool window supports selective filtering for
errors, warnings, or messages.

12 CANopen Configuration Studio for IXXAT CME/PN
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4.2.1 Project Explorer
The Project Explorer tool window lists all devices that are added to the current CANopen Configuration Studio project.

CANopen Configuration Studio for IXXAT CME/PN Project Explorer tool window

Devices are organized in user definable device groups with subordinate device trees. Within these groups, devices are
sorted by their node-ID. For a not yet populated project, a Manager group containing the IXXAT CME/PN and one
Slaves group for CANopen slave devices are created by default. The Slaves group may be renamed by the user to
match specific project requirements. Additional groups may be created by the user to improve the structuring of the
project. See the topic on device groups for more information.

Device groups is a concept introduced to organize devices in a project according to their function. Device
groups are not part of the CANopen specifications, but help understanding the logical structuring of a CANopen
project. Device groups are not related in any way to the actual connection of the devices to the physical CAN
network.

For each device within the network configuration, the project explorer lists the following summary information that is
retrieved from the device description data (EDS). If the corresponding entries are not available in the device
description files, the columns entries will be left empty.

Column Description

Node-ID of the device within a group. The node-ID is displayed both in decimal and
hexadecimal notation.

Name Logical device name, to be provided by the user.

Device Profile Device profile number extracted from the lower 16 bits of object 1000h.

Device Name Manufacturer device name extracted from object 1008h, if available.

Vendor Name Name of device vendor, uses the [VendorName] keyword in the [DeviceInfo] section of
the device description file for the device. Alternatively the content of object 1018h sub-index

01h Vendor-ID is used and matched against an internal reference list of device vendor

names.

CANopen Configuration Studio for IXXAT CME/PN 13
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Toolbar

The project explorer toolbar implements global commands with respect to the CANopen topology of the network:

Icon Description

Opens the Add Group dialog. The user is required to enter a name for the new device group. Optionally the
user may enter a textual description for the device group.

Removes the selected device or group from the project data. Note that a group cannot be removed as long
as it contains any device. The Manager group containing the IXXAT CME/PN gateway device can neither be
removed nor renamed.

Context Menu

The context menu in the project explorer offers the following menu options:

Command Description

Add Group Adds a new group to the project. In addition to the group name the Add Group dialog allows
the entering of a textual description of the group. Please refer to the description above of
device groups in CANopen.

Remove Removes the selected device or group from the project data. Note that a group cannot be
removed as long as it contains any device. The Manager group containing the IXXAT CME/PN
gateway device can neither be removed nor renamed.

Properties Shows either the device or the group properties dialog. The dialogs are identical to the Add
Device, respectively Add Group dialogs and allow to review or alter the device or group
properties including, in case of the Device Properties dialog, the devices node-ID or the group
membership.

Collapse All Collapses all groups such that only the group headers are visible.

Expand All Expands all groups such that all devices in the project are visible below the group headers.

4.2.1.1 Device and Group Properties
Devices are added to a project via a drag & drop operation from the Device Catalog to the Project Explorer tool
window. On this operation the Add New Device dialog is displayed allowing to enter both required and optional
parameters and in addition displays basic device identification information.

14 CANopen Configuration Studio for IXXAT CME/PN
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Add New Device dialog
 

Parameter Category Description

Logical Name required input Logical device name, to be provided by the user.

Node-ID required input Node-ID of the device within a group. The node-ID is displayed both in
decimal and hexadecimal notation.

Group required input Logical device group, used to structure the project.

Device Profile information Device profile number extracted from the lower 16 bits of object
1000h.

Device Name information Manufacturer device name extracted from object 1008h, if available.

Vendor Name information Name of device vendor, uses the [VendorName] keyword in the
[DeviceInfo] section of the device description file for the device.
Alternatively the content of object 1018h sub-index 01h Vendor-ID

is used and matched against an internal reference list of device vendor
names.

Description optional input Textual description of the device. Typically the application functionality
as defined by the system integrator is entered here.

CANopen Configuration Studio for IXXAT CME/PN 15
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Device Groups

CANopen Configuration Studio for IXXAT CME/PN supports structuring CANopen devices in the network in logical
groups. This concept is not described within the CANopen specifications but allows to render the project itself more
clearly.

To add a new logical group to the project select the Add Group menu item in the context menu of the Project
Explorer tool window.

Project Explorer context menu
 

This opens a dialog that allows to enter a name for the new group and a corresponding textual description.

Add New Group dialog
 

Both device and group properties can be modified after they have been added to the project using the corresponding
Device Properties and Group Properties dialogs.

16 CANopen Configuration Studio for IXXAT CME/PN
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4.2.2 Device Catalog
The Device Catalog tool window lists all device descriptions currently added to a device catalog database. Internally
CANopen Configuration Studio for IXXAT CME/PN implements two separate catalog databases, a core catalog than
cannot be changed by the user, and a user catalog to which a user may add or from which the user may remove
devices.

The Device Catalog tool window allows only for browsing the catalog contents, to add or remove particular devices to
the catalog, use the Device Catalog Management dialog.

The Device Catalog tool window uses navigation panes to categorize the individual devices according to their CiA
device profile.

Device Catalog Browser
 

CANopen Configuration Studio for IXXAT CME/PN 17
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Within the individual navigation panes, the following information is displayed if it is available in the electronic data
sheet for the device. If the data cannot be extracted from the device data, the corresponding column is left empty.

Column Description

Multi-purpose column that contains the vendor name, a textual description of the additional
information field in 1000h Device type, or, alternatively, the manufacturer device name in

object 1008h.

Vendor-ID Vendor-ID as assigned by CAN in Automation, contained in object 1018h sub-index 01h.

Product Code Manufacturer specific product code, contained in object 1018h sub-index 02h.

Revision Number Manufacturer specific revision number, contained in object 1018h sub-index 03h.

Hardware Version Hardware version as contained in the electronic data sheet for the device. The value
presented in the list is extracted from object 1009h Manufacturer hardware version.

Software Version Software version as contained in the electronic data sheet for the device. The value presented
in the list is extracted from object 100Ah Manufacturer software version.

RPDOs Number of receive PDOs supported by the device.

TPDOs Number of transmit PDOs supported by the device.

18 CANopen Configuration Studio for IXXAT CME/PN
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4.2.2.1 Device Catalog Navigation
Devices are listed in navigation bar panels, with one individual pane for each device profile. To further categorize the
devices contained in the device catalog CANopen Configuration Studio for IXXAT CME/PN interprets the Additional
information field in object 1000h Device type. Please consult the corresponding device profile specifications
available from CAN in Automation for further information on object 1000h.

The core catalog is pre-configured to contain the device description for the IXXAT CME/PN in NMT master mode. This
catalog is locked against modification by the user.

The user catalog is pre-populated with device description information for selected CiA device profiles, for details see
the table below. If device description information is included in the user catalog a short description of the
corresponding devices functionality is included below the description of the navigation pane. The corresponding EDS
files have been created on the basis of the device profile specifications available from CAN in Automation. They do
not represent any existing commercially available device, they are only intended to demonstrate typical functionality
of the corresponding device profile. During installation the EDS file are copied into the
C:\Users\Public\Documents\IXXAT\CANopen Configuration Studio for IXXAT CME-PN \EDS on
Microsoft Windows 7 systems. See also the information in the First Steps section on the installation directories.

CANopen Configuration Studio for IXXAT CME/PN 19
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CiA 401
device:

CiA 401
device
(Group

messaging):

CiA 402
frequency
converter

(PDO set for
frequency

converter):
CiA 402 servo

controller
(PDO set for
servo drive):

CiA 402 servo
controller

(PDO set for
generic drive

device):

CiA 404
device:

CiA 406
device:

Icon Description

CiA 401, CANopen device profile for generic I/O modules

Device description for generic I/O module with digital and analog input and output,
additional device parameters such as polarity and trigger ranges.

Device description for generic I/O module with digital and analog input and output,
additional device parameters such as polarity and trigger ranges. Additional support for
scanner and dispatcher list (SAM-MPDO).

CiA 402, CANopen device profile for drives and motion control

Generic objects for power drive system control, with support for velocity and profile
torque mode.PDO set for frequency converter according to CiA 402-3 V3.0.

Generic objects for power drive system control with support for profile position mode,
interpolated position mode, profile velocity and homing mode. PDO set for servo drive
according to CiA 402-3 V3.0.

Generic objects for power drive system control with support for profile position mode,
interpolated position mode, profile velocity, and homing mode. PDO set for generic drive
device according to CiA 402-3 V3.0.

CiA 404, CANopen device profile for measuring devices and closed-loop controllers

Device description for CiA 404 compliant digital I/O, analog input device with variable
PDO mapping, granularity 8 bit. Alarm function block with 2 alarms per channel
supported.

CiA 405, CANopen interface and device profile for IEC 61131-3 programmable devices

The corresponding specification has been withdrawn by CiA and its contents has been moved to
other CiA documents. The navigation pane is maintained as a container for legacy devices.

CiA 406, CANopen device profile for encoders

Encoder class C3, standard and high resolution parameters. Constant PDO mapping for
TPDO1 to TPDO3, variable PDO mapping for TPDO4, granularity 8 bit.

CiA 408, CANopen profile for fluid power technology proportional valves and hydrostatic transmissions

CiA 410, CANopen device profile for inclinometer

Devices that do follow a standard CiA device profile or implement a profile for which no specific navigation
bar pane is implemented
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4.2.2.2 Customizing the Device Catalog Appearance
The Device Catalog tool window displays only those device profile navigation panes that are populated with matching
CANopen slave device descriptions. Furthermore the navigation bar allows for user customization of which panes are
shown, and in which sequence those panes are displayed via a context menu.

Context Menu

Navigation bar context menu
 

Icon Command Description

Show More Buttons Use this command to show more navigation panes in the device catalog tool
window.

Show Fewer Buttons Use this command to show fewer navigation panes in the device catalog tool
window.

Navigation Bar Options... Use this command to display the Navigation Bar Options dialog, in which you
can either selectively enable or disable device profile navigation panes. You
may also change the sequence in which the navigation panes are shown.

Note that the sequence of navigation panes is not persisted when
CANopen Configuration Studio for IXXAT CME/PN is closed. After the
next restart the navigation bar will assume the default settings.

Add or Remove Buttons Displays a submenu to selectively enable or disable device profile navigation
panes.
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Adjusting the Navigation Bar Panes

Depending on the number of device profiles for which devices have been added to the device catalog, profile panes
are moved to an overflow tray. To reserve more space in the device tree view, navigation panes may be moved to the
overflow tray area at the bottom of the navigation bar control. Move the mouse pointer over the splitter bar until it
changes to the arrow icon , then drag the splitter bar either up or down to desired position to either increase or
decrease the number of visible navigation panes.

Navigation panes visible Navigation panes collapsed to overflow tray
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4.2.3 PDO Parameters
The PDO Parameters tool window allows direct editing of PDO communication and mapping parameters. This
functionality is restricted to CANopen slave devices as the PDOs of the CANopen manager are configured indirectly
via the Application Objects workspace page.

The PDO Parameters tool window is divided into two sections of control elements: one region  that lists all PDOs
implemented by the device currently selected in the Project Explorer and the objects that are mapped onto these
PDOs, and a second region  that allows the configuration of PDO communication parameters of the PDO currently
selected in the upper region.

 

PDO Parameters tool window
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PDO Mapping Parameters

The PDO mapping parameters section lists all PDOs implemented by the selected CANopen device. For each of these
PDOs, the transmission direction and additional status information is displayed in the header of the PDO. All currently
mapped application objects are indicated below the root element of the PDO. The PDO header may be decorated by
additional icons that are explained below:

Icon Description

The PDO has static mapping. The PDO mapping records are predefined in the device's object dictionary and
are read-only, thus the PDO mapping cannot be changed. The user may modify the PDO communication
parameters. To prevent the automatic PDO calculation from altering the user-selected communication
parameter configuration, the PDO has to be locked (see below) before the calculation process.

The current PDO configuration is locked and neither PDO mapping parameters nor PDO communication
parameters can be changed by the user. The automatic PDO mapping and linking calculation will not affect
the current configuration. To re-enable the configuration options, uncheck the Lock PDO check mark in the
PDO communication parameters section.

The PDO has static mapping. In addition the PDO is locked, which implies that the PDO communication
parameter cannot be modified.

No
icon

The PDO has variable PDO mapping, and thus may be modified by the user. To prevent the automatic
mapping calculation from altering either the mapping or the communication parameters configuration, the
PDO has to be locked by the user.

Toolbar and Context Menu

The toolbar and the context menu of the PDO list implement commands that may be used to change the PDO
mapping configuration of the PDOs implemented by the selected CANopen device. By means of the available
commands, additional application objects may be added to the PDO, objects may be removed from the mapping
tables, or the sequence in which the objects are mapped onto the PDO may be modified. If a command is not
available for the selected PDO or object the corresponding toolbar button and context menu item are disabled.

Icon Context menu item Description

Add Object Adds a new application object to the mapping table of the selected PDO.

Remove Object Removes the selected application object from the mapping table of the PDO.

Move Up Move the selected application object up in the PDO mapping table.

Move Down Move the selected application object down in the PDO mapping table.

Collapse All Move the selected application object down in the PDO mapping table.

Expand All Expands all PDOs such that all mapped application objects are visible below the PDO
header.
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The display style of the PDO list may be adjusted to display only those PDOs that match certain filter criteria. To
display or hide the filter options, click the PDO filter icons ( , ). The following filter options are available via combo
box controls.

Selection of PDO filters via drop down menus
 

To activate or deactivate the PDO filter, click the toggle PDO filter button ( ) in the toolbar of the PDO mapping list.
The current filter settings are display in the toolbar of the PDO list.

Filter Description

PDO Type All If the PDO filter is active, all PDOs that match the other filter criteria are
visible in the PDO list.

RPDO If the PDO filter is active, only receive PDOs that match the other filter
criteria are visible in the PDO list.

TPDO If the PDO filter is active, only transmit PDOs that match the other filter
criteria are visible in the PDO list.

PDO Enabled All If the PDO filter is active, all PDOs that match the other filter criteria,
are visible in the PDO list.

Yes If the PDO filter is active, only PDOs that are enabled and for which the
other filter criteria are valid are visible in the PDO list. Enabled means
that bit 31 in the COB-ID parameter of the PDO communication
parameter record is set to 0.

No If the PDO filter is active, only PDOs that are disabled and for which the
other filter criteria, are valid are visible in the PDO list. Disabled means
that bit 31 in the COB-ID parameter of the PDO communication
parameter record is set to 1

Transmission Type All If the PDO filter is active, all PDOs for which the other filter criteria are
valid are visible in the PDO list.

Event-driven If the PDO filter is active, only event-driven PDOs are visible in the PDO
list, provided they match the other filter criteria.

Synchronous If the PDO filter is active, only event-driven PDOs are visible in the PDO
list, provided they match the other filter criteria.
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For each mapped application object the following information is available:

Column Description

Index Main-index of the application object in the CANopen devices object dictionary.

Sub-index Sub-index of the application object in the CANopen devices object dictionary.

Size (bit) Length of the application object in bits.

Parameter Name Name of the application object as extracted from the [ParameterName] keyword in the
electronic data sheet of the device.

Denotation User assigned alternative object name as entered in the Denotation column of the Application
Objects workspace page.

26 CANopen Configuration Studio for IXXAT CME/PN

©2015 IXXAT Automation GmbH. All Rights Reserved.



PDO Communication Parameters

The lower section of the PDO list tool window contains the PDO communication parameters. All values that are shown
in this section refer to the PDO currently selected in the PDO list in the upper section of the tool window. For each
PDO the following communication parameters may be configured:

Communication
Parameter

Description

Enabled Checkbox that allows to activate (checkbox is checked) or deactivate (checkbox is unchecked)
the PDO. This functionality corresponds to bit 31 in the COB-ID parameter of the PDO
communication parameter structure (sub-index 01h).

CAN-ID CAN identifier used by this PDO in hexadecimal notation.

Note that the IXXAT CME/PN supports only 11 bit CAN-IDs. If it is attempted to enter
values that exceed the supported CAN identifier range, an error icon  is displayed to
the right of the input field. When positioning the mouse pointer over the error icon
detailed error information is available with a tooltip.

Transmission Type Transmission type of the PDO. If the transmission type Synchronous (cyclic) is selected,
the transmission rate may be further specified in the Transmission Rate numeric input control
(see below).

Transmission Rate Numeric input control to specify the transmission rate of the selected PDO. The control is only
enabled if the transmission type Synchronous (cyclic) is set for the selected PDO.

Inhibit Time Inhibit time for the selected PDO in multiples of 100 microseconds. If the value entered by the
user exceeds the allowed value range an error icon  is displayed to the right of the input
field. When positioning the mouse pointer over the error icon detailed error information is
available with a tooltip. The input field is disabled if the functionality is not supported by the
selected PDO.

Event Timer Event timer for the selected PDO in multiples of 1 millisecond. If the value entered by the user
exceeds the allowed value range an error icon  is displayed to the right of the input field.
When positioning the mouse pointer over the error icon detailed error information is
available with a tooltip. The input field is disabled if the functionality is not supported by the
selected PDO.

Lock PDO Checkbox to prevent the current PDO configuration from being modified by the PDO
mapping calculator. If checked, the current PDO mapping, CAN-ID and transmission type of
the PDO cannot be changed. If unchecked, the PDO mapping may be configured using the
toolbar of the PDO list. For details on how to change the PDO mapping see the section on
Configuring the PDO Mapping.
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4.2.3.1 Configuring the PDO Mapping
The mapping of application objects into the transmit and receive PDOs of a device can be changed using the
commands available in the toolbar or the context menu. The user may add objects to a PDO, remove object from a
PDO, or change the sequence in which the application objects appear within the PDO.

To be able to modify the PDO mapping, the CANopen device has to support variable, or dynamic, PDO
mapping. This implies that the object dictionary entries describing the PDO configuration have to support read-
write access.

 

Changes that a user has applied to the default PDO configuration, such as adding additional objects to the PDO
mapping, will be overwritten by the object linker if the PDO is not locked.

 

Configuration Commands

Add a new Object to the PDO Mapping

To be able to add an object to the mapping tables of a PDO, adequate space has to be available to allow for the
additional object without exceeding the maximum data length of a CAN frame (8 bytes). As the IXXAT CME/PN
supports only byte granularity for PDOs, Boolean objects cannot be mapped onto a PDO. By default, new application
objects are added at the end of the mapping table. Use the Move Up or Move Down commands to change the
mapping sequence if required.

To add an application object to a PDO, select the PDO first. Clicking the toolbar button ( ) or selecting the context
menu item over the PDO header line will open the Object List dialog that allows to add one or multiple objects from a
list of application objects which have the PDO mapping attribute set to true. The Object List dialog will display only
those objects for which the input/output direction matches the selected PDO. For example, a read-only object cannot
be mapped onto a receive PDO.
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Object List dialog
 

Remove one Application Object from the PDO Mapping

To remove an application object from the PDO mapping tables, select the object in the PDO list and click either the
Remove Object toolbar button ( ) or select the corresponding context menu item.

Reorder Objects in the PDO Mapping Table

To change the sequence with which application objects are transmitted within a PDO message, select a single object
and click either the Move Up ( ) or Move Down ( ) toolbar buttons or select the corresponding menu items in the
context menu of the PDO list.

Changes to the PDO mapping affect only the currently selected PDO. Connected PDOs on other devices are not
automatically modified and need to be correspondingly changed by the user.

CANopen Configuration Studio for IXXAT CME/PN 29

©2015 IXXAT Automation GmbH. All Rights Reserved.



4.2.4 Device Parameters
The Device Parameters tool window provides access to parameter objects of the CANopen device that is currently
selected in the Project Explorer tool window. Parameter objects may be additionally mapped onto PDO messages,
depending on the PDO mapping attribute declared in the electronic data sheet (EDS) of the device. Output
parameters, for example, may require specific initialization with an alternative parameter value instead of the default
value during network startup.

Device Parameters tool window
 

Object List

The object list is populated with object information extracted from the device catalog information for the selected
device. Within the list, objects are grouped according to their object dictionary area (communication, manufacturer,
and device standardized device or application profile area), and for complex objects, the index. For each object, the
following information is available:
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Column Description

Index Index and sub-index of the parameter in the object dictionary of the CANopen device. Sub-
indices for complex objects such as arrays or records are listed in a tree structure attached to
the main object. In addition to index and sub-index, this column contains an icon indicating
the CANopen data type of the parameter object.

Objects that are read only or may not be configured within the Device Parameters tool
window are disabled (gray text).

Parameter Name Name of the object entry as declared in the [ParameterName] keyword in the device
description file.

Value Configured value of the parameter object. The value may be changed within the limits
indicated in the low limit and high limit columns. To change a parameter value, double click
into the cell, enter the new value, and hit <return> when finished. The new value is verified
against the permitted value range as indicated by the low and high limit columns.

Default Value Default value of the parameter as declared in the [DefaultValue] keyword in the device
description file. The default value is reapplied if either an individual or all parameter objects
are reset using one of the toolbar buttons.

Low Limit Minimum value for the parameter object, if available. The field uses the value declared by the
[LowLimit] keyword in the EDS file.

High Limit Maximum value for the parameter object, if available. The field uses the value declared by the
[HighLimit] keyword in the EDS file.

Resetting a single Object or all Objects to their Default Values

Icon Description

Resets the selected parameter object to its default value as declared in the electronic data sheet (EDS).

Resets all parameter objects on the selected device to their default values as declared in the electronic data
sheet (EDS).

Context Menu

The context menu in the object list offers the following menu options:

Command Description

Collapse All Collapses all profile areas and complex objects such that only the headers of the object
dictionary profile areas are visible

Expand All Expands all objects such that all object entries and sub-entries are visible below the object
dictionary profile area's headers.
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4.3 Workspace Pages
CANopen Configuration Studio for IXXAT CME/PN uses workspace pages for network wide configuration tasks.
Workspace pages are used to configure the network management functionality of the managing device. Also the NMT
error control dependencies between the devices of the network are configured by a workspace page. Additionally the
process data are configured in this area, including the selection of mapped application objects and inspection of the
created process image on the managing device.

For detailed information on the workspace pages see the following sections.

Icon Name Description

Network Management
Configuration

Configuration of the network management functionality.

Error Control Configuration Definition of the NMT error control dependencies of the devices providing
heartbeat and/or node guarding.

Application Objects Configuration of the objects that shall be mapped to the managers process
image.

Process Image Additional information about the created process image. Also contains some
options to fine-tune the process image.

Timing Parameters Configuration of PROFINET and CANopen timing parameters.

Properties Basic project information such as project path, project author and creation,
respectively modification dates. Allows also to enter a short textual description
of the project. This page is not displayed by default. See menu system and
toolbars on how to activate the properties page.
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4.3.1 Network Management Configuration
The network management page supports configuration of the NMT functionality of the managing device.

Network Management Configuration
 

The network management configuration page is subdivided into three main regions explained in detail below. In all
regions extensive tool tips provide direct help detailing the configuration settings for individual bit or the value range
of the corresponding CANopen objects.

NMT Startup configuration

Slave Assignment configuration

Additional CANopen manager objects

NMT Startup Configuration

The NMT startup configuration specifies the behavior of managing and self-starting devices in the network. The
configuration corresponds to object 1F80h NMT startup of these devices. All bits except bit 0 NMT master may
be configured. Bit 0 is read-only as the active manager can not be changed after the project was created.

Column Description

Node-ID Node-ID of the device in decimal notation.

Name Logical device name, to be provided by the user.

NMT Startup Gives access to the individual bits of object 1F80h NMT startup for each device in the

network implementing this object.
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1F80h NMT Startup Bit Description

Bit Number Name Description

0 NMT master
(read-only)

0 = CANopen device is not NMT master.

1 = CANopen device is the NMT master.

1 Start all nodes 0 = NMT service start remote node for each node-ID.

1 = NMT service start remote node with node-ID = 0.

2 NMT master start 0 = Shall switch into NMT state Operational in the process NMT
startup.

1 = Shall not switch into the NMT state Operational by itself.

3 Start node 0 = The NMT master shall start the NMT slaves.

1 = The NMT master shall not start the NMT slaves and the application
may start the NMT slaves.

4 Reset all nodes 0 = In case of error control event of a CANopen device defined as
mandatory the NMT service reset node with node-ID of the CANopen
device that caused the error control event shall be executed.

1 = In case of error control event of a CANopen device defined as
mandatory the NMT service reset node with node-ID = 0 shall be
executed.

5 Flying master 0 = CANopen device shall not participate the NMT flying master
negotiation.

1 = CANopen device shall participate the NMT flying master
negotiation.

Note that NMT flying master functionality is not supported by
the IXXAT CME/PN gateway.

6 Stop all nodes 0 = In case of error control event of a CANopen device defined as
mandatory the action as defined by bit 4 shall be executed.

1 = In case of error control event of a CANopen device defined as
mandatory the NMT service Stop remote node with node-ID = 0 shall
be executed. Bit 4 shall be ignored.
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Slave Assignment Configuration

The slave assignment configuration specifies how the manager will treat its slave devices. Most options are related to
network startup and configuration verification which also takes place during startup.

Column Description

Node-ID Node-ID of the device in decimal notation.

Name Logical device name, to be provided by the user.

NMT Slave
Assignment

Configures the Configuration byte of object 1F81h NMT slave assignment in the

manager.

Retry factor and Guard time bytes of object 1F81h NMT slave assignment

are configured on the Error Control page in the workspace.

Restore
Configuration

Configuration of object 1F8Ah Restore configuration on the CANopen manager that

defines the restore procedure for a CANopen device during startup.

Device Type Contains the device type that shall be expected during the verification. Corresponds to object
1F84h Device type identification. The checkbox activates the identification of the

device type for the specific slave. The value for the device type is read from the EDS and can
not be entered manually.

Vendor-ID Contains the vendor-ID that shall be expected during verification. Corresponds to object
1F85h Vendor identification. The check-box activates the identification of the

vendor-ID for the specific slave. The value for the vendor-ID is read from the EDS and can not
be entered manually.

Product Code Contains the product code that shall be expected during verification. Corresponds to object
1F86h Product code. The checkbox activates the identification of the product code for the

specific slave. The value for the product code is read from the EDS and can not be entered
manually.

Revision Number Contains the revision number that shall be expected during verification. Corresponds to
object 1F87h Revision number. The checkbox activates the identification of the revision

number for the specific slave. The value for the revision number is read from the EDS and can
not be entered manually.

Serial Number Contains the serial number that shall be expected during verification. Corresponds to object
1F88h Serial number. The value is entered in hexadecimal format. All values other than

00000000h activate the verification of the serial number.

Expected
Configuration

Contains the expected date of the configuration of the device in the manager. Corresponds to
objects 1F26h Expected configuration date and 1F27h Expected

configuration time. The value cannot be entered manually. It is set from system time
during configuration file generation. By means of the check boxes the mechanism may be
deactivated.
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1F81h NMT Slave Assignment Bit Description (Byte 0 Configuration)

Bit Number Name Description

0 NMT slave 0 = NMT master or not available in the network.

1 = NMT slave and available in the network.

2 NMT boot slave 0 = Configuration and NMT service Start remote node shall not be
allowed in case of error control event or NMT service Boot-up.

The application is responsible for the NMT slave startup.

1 = Configuration and NMT service Start remote node shall be
performed in case of error control event or NMT service Boot-up.

3 Mandatory 0 = CANopen device may be present prior to network startup
(CANopen device is optional).

1 = CANopen device shall be present prior to network startup
(CANopen device is mandatory).

7 Restore 0 = CANopen device may be used without prior resetting.

1 = CANopen device shall be reset to factory defaults by issuing a
restore to defaults (object 1011h).

1F8Ah Restore Configuration Value Description

Value Description

01h All parameters are restored.

02h Communication related parameters. All objects from index 1000h to 1FFFh are restored.

03h Application related parameters All objects from index 6000h to 9FFFh are restored.

04h to 7Fh Manufacturer specific restore behavior is performed.

80h to FEh Reserved for future use.

Additional Manager Objects

The active managing device supports additional objects used to configure the startup behavior.

Object 1F89h Boot time defines the time out in milliseconds between start of the process Start process boot NMT
slave and signaling of successful boot of all mandatory NMT slaves.

Object 102Ah NMT Inhibit Time specifies the configured inhibit time in units of 100µs between two subsequent
NMT node control messages. Not yet transmitted NMT messages are queued and transmitted in order of their
occurrence respecting the specified inhibit time.
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4.3.2 Error Control Configuration
The Error Control Configuration page implements user interface controls enabling the user to configure the NMT error
control functionality and dependencies of the devices within the network. Depending on the functionality
implemented by the devices, the configuration of either heartbeat or node guarding functionality is supported.

Error Control Configuration
 

The Error Control Configuration page is subdivided into the following main regions:

Toolbar

Error control configuration

Default values

Toolbar

The toolbar implements commands that perform global operations on the NMT error control parameters.

Icon Description

Resets all error control objects of the devices to the EDS defaults.

Initializes all values in the error control objects of the devices to the values preset in the default values
region in the lower part of the workspace page. If both heartbeat and node guarding are supported by a
device, heartbeat is enabled and node guarding is disabled.
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Error Control Configuration

The error control list supports the parameterization of the individual error control objects implemented by the devices
in the network. If a device does not support a particular functionality the corresponding entry will be marked as not
available (N/A).

Column Description

Node-ID Node-ID of the device in decimal notation.

Logical Name Logical device name, to be provided by the user.

Producer Heartbeat
Time

Configures object 1017h Producer heartbeat time of the selected CANopen device.

The value is measured in milliseconds and defines the configured cycle time of the heartbeat
message transmitted by the CANopen device. A value of 0 (zero) deactivates the transmission
of the heartbeat message.

Consumer Heartbeat
Time

Configures object 1016h Consumer heartbeat time of the selected CANopen device.

The value is specified in milliseconds and defines the expected heartbeat cycle times. The
monitoring of a heartbeat producer will start with the reception of the first heartbeat
transmitted by the CANopen device. As this entry may contain a different value for each
monitored device a drop-down menu is available for detailed configuration of the consumer
heartbeat times. The drop-down menu may be opened by clicking the ellipsis button ( )
which appears if a cell is selected.

Guard Time (Slave) Configures object 100Ch Guard time for the selected CANopen device. The value is

specified in milliseconds and specifies the interval within which the slave expects a guarding
request by the NMT master in order to consider it functional.

Life Time Factor Configures object 100Dh Life time factor for the selected CANopen device. The value

is specified in milliseconds. The value specifies how many successive times a missing guarding
by the NMT master e will be tolerated before an error event is raised on the CANopen device.

Guard Time (Master) Configures the Guard time field of object 1F81h NMT slave assignment. The value is

specified in milliseconds and configures the cycle time for the node guarding of the CANopen
device.

Retry Factor Configures the Retry factor field of object 1F81h NMT slave assignment. The value

specifies how many successive times a missing guarding response will be tolerated before the
CANopen slave is considered unavailable.
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The CANopen specifications state that heartbeat and node guarding must not be concurrently used for the same
device. Thus CANopen Configuration Studio for IXXAT CME/PN will require the user to deactivate one of the
mechanisms if an entered value would cause both mechanisms to be activated.

The consumer heartbeat time(s) (object 1016h) is configured in an extended context menu. The menu is opened by

clicking the ellipsis button ( ) which appears when the consumer heartbeat cell is selected. The list contains as many
entries as supported by the selected device.

Configuration of Consumer heartbeat time
 

Column Description

Node-ID Contains the node-ID of a CANopen device that shall be monitored by the selected device.
Entries containing the text string Not used are not active.

Consumer Time Configures the consumer heartbeat time that shall be applied for the selected device. When a
new device is added the initial value will be preset based on the values in the default section.

Default Values

The default values are used for configuration operations on the error control page.

The value entered in the Error Control Timeout field is used to preset object 1017h Producer heartbeat time
respectively object 100Ch Guard time on the CANopen slave. It is also used to set the Guard time field of the
sub-index in object 1F81h NMT slave assignment on the NMT master corresponding to the node-ID of the
CANopen slave. If the Set command of the tool bar is executed the value is written to all devices as either producer
heartbeat time or guard time. As CANopen specifies that only either heartbeat or node guarding may be used to
monitor a CANopen device, CANopen Configuration Studio for IXXAT CME/PN will first configure the heartbeat
functionality. Only if heartbeat is not supported by a device CANopen Configuration Studio for IXXAT CME/PN will
configure node guarding.

The Node Guarding Retry Factor is used as an initial default for object 100Dh Life time factor on the CANopen
slave and the Retry factor field in the sub-indices in object 1F81h NMT slave assignment on the NMT
master if guarding is activated.

The value entered in Ratio Consumer Heartbeat Time to Producer Time is used to calculate the initial value for the
consumer heartbeat time based on the producer heartbeat time configured for the CANopen device to be monitored.
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4.3.3 Application Objects
The specification which of the process data implemented by CANopen slave devices in the network are mapped to the
process image on the CANopen manager device is performed on the Application Objects workspace page.

Application Objects workspace page
 

The application objects page is subdivided into the following main regions:

Toolbar

Application objects list

Global parameters
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Toolbar

The toolbar implements the interface to commands that globally select or deselect application objects for mapping
onto the process image on the CANopen manager.

Icon Description

Adds all mappable application objects to the process image of the manager.

Removes all currently selected objects from the process image of the manager.

The toolbar also displays the number of bytes currently allocated in the process image on the CANopen manager for
the direction IN and OUT. If one of these values exceeds the upper limit specified in the global values section, the
display changes to text color red.

Application Objects List

The application objects list displays all mappable objects on the CANopen slave devices in the network in a tree list
view. The application objects are sorted according to the node-ID of the device, their object index, and finally the sub-
index of the entry.

Column Description

Index Contains index and sub index of all mappable application objects organized in a tree
structure.

Parameter Name The name of the object entry as declared in the [ParameterName] keyword in the device
description data (EDS).

Mapped Checkbox that is used to map or unmap an object to the managers process image.

Direction Indicates the data direction of the object. IN means the data is transferred from the network
devices to the manager. OUT means data is transferred from the manager to the network
devices.

Data Type Indicates the CANopen data type of the object.

Transmission Type Configures the CANopen transmission type that shall be used for transferring the object data.
May be set to:

Synchronous (acyclic)
Synchronous (cyclic)
Event-driven (profile specific)

This field is read-only if the object is mapped via default mapping.

No of SYNC If the transmission type is set to Synchronous (cyclic), this field allows to configure the
number of SYNC messages that have to be received before the PDO producer samples input
data and triggers the PDO transmission. The field is disabled if a transmission type other than
Synchronous (cyclic) is configured. The default value is 1, the allowed value range 1 -
240.

Denotation Configures an alternative name for the object entry.
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Context Menu

Command Description

Select All of Device Adds all application objects of the selected device for which the PDO mapping attribute is set
to true to the process image of the CANopen manager.

Select Default
Mappings of Device

Opens a dialog which allows the selection of PDOs including their default application object
mapping according to the device description data in the EDS file.

Remove All of
Device

Removes all currently selected application objects of the selected device from the process
image of the CANopen manager.

Global Parameters

The global value section allows to configure parameters which apply to the PDO mapping and PDO communication in
general.

The Communication Cycle Period specifies with which interval a SYNC producer shall transmit a SYNC message. The
field corresponds to object 1006h Communication cycle period of the CANopen manager in the IXXAT
CME/PN.

Please note that the value entered in the text field uses one millisecond as time basis, and not one micro second
as specified in the CANopen application layer and communication profile specification CiA 301.

The SYNC Producer combo box allows to select an alternative producer of the CANopen synchronization message
from a list of all devices in the network that support SYNC producer functionality. This will cause the specified
communication cycle period object to be configured on the selected device and the generate bit (bit 30) in object
1005h COB-ID SYNC to be set to 1b. On all other devices the generate bit in object 1005h is set to 0b.

Process Image Size (IN/OUT) define the upper limit for the process image on the IXXAT CME/PN in byte that may be
allocated by network variables. In CANopen Configuration Studio for IXXAT CME/PN those values are read only and
correspond to the fixes sizes supported by the IXXAT CME/PN gateway. The currently allocated part of the process
image is indicated in the toolbar.

4.3.3.1 Network Variables
Internally IXXAT CME/PN implements a process image with dynamically created network variables according to CiA
302-4 to map the application objects of the connected CANopen slave devices into the process image of the
PROFINET gateway application. Due to the restrictions of PROFINET with respect to supported data types, not all data
types defined in the CANopen specifications are supported by IXXAT CME/PN. For details consult the related
PROFINET specifications and see the table below.
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Data Type Definitions and Object Dictionary Index Range

Input network variables Output network variables

Index range Data type Index range Data type

A000h to A03Fh INTEGER8 A480h to A4BFh INTEGER8

A040h to A07Fh UNSIGNED8 A4C0h to A4FFh UNSIGNED8

A080h to A0BFh BOOLEAN1) A500h to A53Fh BOOLEAN1)

A0C0h to A0FFh INTEGER16 A540h to A57Fh INTEGER16

A100h to A13Fh UNSIGNED16 A580h to A5BFh UNSIGNED16

A140h to A17Fh INTEGER241) A5C0h to A5FFh INTEGER241)

A180h to A1BFh UNSIGNED241) A600h to A63Fh UNSIGNED241)

A1C0h to A1FFh INTEGER32 A640h to A67Fh INTEGER32

A200h to A23Fh UNSIGNED32 A680h to A6BFh UNSIGNED32

A240h to A27Fh REAL32 A6C0h to A6FFh REAL32

A280h to A2BFh UNSIGNED401) A700h to A73Fh UNSIGNED401)

A2C0h to A2FFh INTEGER401) A740h to A77Fh INTEGER401)

A300h to A33Fh UNSIGNED481) A780h to A7BFh UNSIGNED481)

A340h to A37Fh INTEGER481) A7C0h to A7FFh INTEGER481)

A380h to A3BFh UNSIGNED561) A800h to A83Fh UNSIGNED561)

A3C0h to A3FFh INTEGER561) A840h to A87Fh INTEGER561)

A400h to A43Fh INTEGER64 A880h to A8BFh INTEGER64

A440h to A47Fh UNSIGNED64 A8C0h to A8FFh UNSIGNED64

1) Not supported by IXXAT CME/PN

4.3.3.2 Default PDO Mapping
CANopen Configuration Studio for IXXAT CME/PN supports the explicit selection of PDO mapping records as declared
in the device description information for the CANopen slave devices. To select individual PDOs to be mapped into the
process image of the CANopen manager, right click in the application object list to open the Select Default Mapping
dialog. In this dialog all PDOs declared for the CANopen device are listed with the application objects mapped onto
the PDO.

By selecting the desired PDOs and confirming the dialog, all application objects of the PDOs are added to the
mapping and corresponding network variables are created in the process image of the CANopen manager. Objects
that were selected via a default mapping are displayed with a yellow background in the application object list. Such
objects are treated as one unit and can only be removed together.
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Select Default Mapping Dialog

The default mapping dialog is shown if the corresponding option in the context menu was selected.

Selection of PDO default mapping as contained in the device description file
 

Column Description

Index Contains the main-index of the application object contained in the default mapping of the
PDO.

Transmission Type /
Sub-index

Allows to configure the PDO transmission type in the corresponding header row individually
for each PDO /
Contains the sub-index of the application object contained in the default mapping of the
PDO.

No of SYNC /
Size (bit)

If synchronous (cyclic) is selected as transmission type the number of SYNC messages after
which a TPDO is transmitted may be specified /
Contains the size of the object in bits.

Parameter Name The name of the default mapped object according to the EDS.

Denotation The alternative name for the object as specified by the user. The value can not be changed
here.
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4.3.4 Process Image
The process image page displays the process image of the CANopen manager that is created by the configuration.

Process Image workspace page
 

The process image page is subdivided into the following main regions:

Toolbar

Process image list

Toolbar

The tool bar interfaces to commands related to the process group mechanism and process image sorting.

Process image groups provide a way to optimize the process image layout. This is a concept that is not defined by
CANopen. Objects that are placed in the same group will be allocated in a continuous memory space inside the
process image to allow for a more efficient exchange of process data with the PLC program. The process groups are
managed via the tool bar.

Icon Description

Combo box The combo box allows to select the process groups that were created. The group default is always
available.

Assigns the process group selected in the combo box to all entries selected in the process image list.

Adds a new process group which is subsequently displayed in the combo box.

Removes the group selected in the combo box. All process image entries that are in the removed
group are moved to the default group.

Sorts the entries of the process image list by ascending order of addresses.

Sorts the entries of the process image list by ascending order of node-ID, main-index and sub-index.
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Process Image List

The process image list displays all objects that were mapped to the process image of the CANopen manager. Objects
that are highlighted with a alternate background color have been added to the list of objects selected for inclusion
into the process image after the last calculation of the PDO connections and the process image layout. The Address
column for those objects will remain empty until the project is recalculated.

Column Description

Group Contains the process group that was assigned to the object.

Direction Displays the transfer direction of the data as seen from the manager.

Node-ID The node-ID of the CANopen slave device implementing the object that is mapped onto the process
image.

Index Main-index of the object on the CANopen slave device.

Sub-Index Sub-index of the object on the CANopen slave device.

Parameter
Name

The name of the object on the slave according to the device description data (EDS).

Denotation The optional alternative name entered on the application objects page. The value cannot be changed
here.

Data Type The CANopen data type of the object.

Address The address of the objects value in the process image in hexadecimal representation. The address
space is divided into an IN and OUT direction. Thus the same address may occur twice. If the
mapping was not calculated since an object was added the address column is empty for this object.

Size (bit) The size of the object in bits.
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4.3.5 IXXAT CME/PN Timing Parameters
The Timing Parameters page is used to configure basic timing parameters such as the bit rate of the CAN network
connected to the IXXAT CME/PN or the PROFINET update time for the IXXAT CME/PN I/O device.

Note that due to the higher bit rate of PROFINET (100 Mbit/s) compared to CANopen (10 .. 1000 kbit/s) the
available bandwidth of PROFINET is significantly higher than that of CANopen. It has to be taken care to
carefully adjust the PROFINET update time as a function of:

the shortest duration of process data to be exchanged between the CANopen slave devices and the
PROFINET network
the CANopen bit rate
the amount of process data

to avoid loss of data.

Note that the source of process data (the PLC) and the PROFINET bus are not synchronized. Therefore the
following two criteria shall be met:

1. The PROFINET update time shall be greater than the transmission time of all configured TPDOs and
RPDOs.

2. The PROFINET update time shall be less or equal to half of the shortest process data duration.

CANopen and PROFINET timing parameters
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Based on the configured timing parameters and the calculated PDO configuration an approximation of the time
required to transmit each TPDO exactly once per PROFINET update time is calculated. This estimated transmission
time, and thus also the expected busload, is independent of the configured PDO transmission type. If the TPDO
transmission type is set to event-driven, an input device may transmit its TPDOs more than once per PROFINET
update time. The estimated transmission time and busload on the CANopen network may therefore differ from the
observed busload in the final network installation.

Parameter Control Type Category Description

CANopen Bit Rate Drop Down List Input Bit rate used in the CANopen network. According to
CiA 301, the CAN bit rate can be selected within the
range of 10 kbit/s to 1 Mbit/s.

PROFINET Update Time Drop Down List Input The cycle time in a PROFINET system within which
the I/O device is polled by the I/O controller. The
PROFINET update time is an integer multiple of the
basic PROFINET cycle time. The IXXAT CME/PN
supports PROFINET update times between 1 ms and
512 ms.

Total PDO Payload Textbox Information Accumulated payload of all active TPDOs
transmitted within one PROFINET update time. The
value in this textbox depends on the selected
application objects in the Application Objects page
and additional TPDOs configured in the PDO
Parameters tool window.

Total PDO Length Textbox Information For each active TPDO, 47 bits for the additional CAN
protocol information (start of frame, arbitration,
control, CRC, and ACK fields, EOF, and inter frame
space) are added. An estimated 4% is added to each
TPDO to cover for possible stuff bits in the CAN
frames. The resulting value is rounded up to the
next full byte.

This estimate is based on the assumption that
each TPDO is transferred exactly once within
one PROFINET update time.

Total PDO Transmission
Time

Textbox Information Total PDO length divided by the CANopen bit rate.
A warning icon  is displayed next to this textbox if
the estimated total PDO transmission time exceeds
the PROFINET update time.
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Example Calculation of the PDO Transmission Time

For the example calculation the CANopen project as depicted above is used.

IXXAT CME/PN as CANopen manager device
3 CiA 402 compliant CANopen servo drives,
each with RPDO1 (2 byte payload), RPDO3 (6 byte payload) and TPDO3 (6 byte payload) active

Node-ID

PDO
Number

PDO Mapping Payload
(byte)

Payload
(bit)

PDO
Frame
Length1)

Total
PDO
frame
Length2)

Name
Index Sub-

index
Data Type

0x11 RPDO1 Control
word

6040h 00h UNSIGNED16 2 16 63 66

RPDO3 Control
word

6040h 00h UNSIGNED16 6 48 95 99

Target
position

607Ah 00h UNSIGNED32

TPDO3 Status
word

6041h 00h UNSIGNED16 6 48 95 99

Actual
position

6064h 00h UNSIGNED32

0x12 RPDO1 Control
word

6040h 00h UNSIGNED16 2 16 63 66

RPDO3 Control
word

6040h 00h UNSIGNED16 6 48 95 99

Target
position

607Ah 00h UNSIGNED32

TPDO3 Status
word

6041h 00h UNSIGNED16 6 48 95 99

Actual
position

6064h 00h UNSIGNED32

0x13 RPDO1 Control
word

6040h 00h UNSIGNED16 2 16 63 66

RPDO3 Control
word

6040h 00h UNSIGNED16 6 48 95 99

Target
position

607Ah 00h UNSIGNED32

TPDO3 Status
word

6041h 00h UNSIGNED16 6 48 95 99

Actual
position

6064h 00h UNSIGNED32
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Total PDO
payload
(byte) 42 

Total
PDO
length
(bit)

792

Total
PDO
length
(byte)

99 

1) Frame length in bits covering payload plus CAN protocol overhead (44 bit) plus inter frame space (3 bit)
2) Total frame length in bit allowing for 4% overhead due to CAN stuff bits for statistically generated data bit

sequences

PROFINET update time according to criterion 1

At a CAN bit rate of 125 kbit/s this results in a total PDO transmission time of 6.3 ms . Not considering
asynchronous services and events such as SDO transfers or emergency messages or NMT error control services, the
PROFINET update time has to be set to at least 8 ms to avoid loss of process data. If the PROFINET update time was
set to 4 ms, a warning icon would be displayed behind the total PDO transmission.

CANopen and PROFINET timing parameters with PROFINET update time too short
 

Allowing for additional available bandwidth, it is recommended to set the PROFINET update time for this
configuration to no shorter than 16 ms.

Node-ID

PDO
Number

PDO Mapping Payload
(byte)

Payload
(bit)

PDO
Frame
Length1)

Total
PDO
frame
Length2)

Name
Index Sub-

index
Data Type
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PROFINET update time according to criterion 2

With the PROFINET update time equal to 16 ms the shortest duration of process data shall be 32 ms or longer. See
figure below:

Timing diagram for 16 ms update time and 32 ms process data duration. t1, t3: internal delay times of PLC and
IXXAT CME/PN. t2: total PDO transmission time
 

If criterion 2 is not met criterion 1 must be re-calculated based on a higher bit rate, e. g. 250 kBit/s.
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4.3.6 Project Properties
The project properties page displays some basic information about the current project. The page is not displayed by
default. It is available via the Properties item in the Project menu.

Project Properties
 

 

Parameter Description

Name Contains the full path and name of the project file.

Created by The name of the creator of the project. This value may be freely assigned.

Creation Date Time and date of the creation of the project. This value is automatically set on creation based
on system time.

Modified by The name of the modifier of the project. This value may be freely assigned.

Modification Date Time and date of the last modification of the project. This value is automatically set on save
based on system time.

Description An optional description of the project. This value may be freely assigned.
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4.4 Dialogs
CANopen Configuration Studio for IXXAT CME/PN implements four global dialogs that allow to configure basic
settings of the application.

Icon Name Description

Interface Settings Configuration of the network interface used for downloading the
generated configuration data to the IXXAT CME/PN.

Download Selection of the configuration data to be downloaded to the IXXAT
CME/PN. The status of the download operation is indicated by a
progress bar.

Device Catalog Management Use the Device Catalog Management dialog to add CANopen devices
to or remove them from the user catalog. See also the help information
on the Device Catalog tool window.

Options Supports setting of general application options.

4.4.1 Interface Configuration
The Interface Settings dialog is used for the basic configuration of the download interfaces. The dialog is available via
the Network→Interface Configuration menu item or the corresponding tool bar item. CANopen Configuration Studio
for IXXAT CME/PN supports download via a USB link directly connected to a IXXAT CME/PN.

USB Configuration

The USB port tree provides a list of all IXXAT CME/PN devices that are attached to the PC via USB. By selecting a
device this device will be targeted by the download via USB. The USB interface does not require further configuration.
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Selection of a IXXAT CME/PN gateway as target device for the configuration download
 

4.4.2 Download of Configuration Data
The Download dialog is used to download network configuration data to a IXXAT CME/PN. The dialog is available via
the Network→Download menu item or the corresponding toolbar button ( ). CANopen Configuration Studio for
IXXAT CME/PN supports download via a direct USB link between the host PC running CANopen Configuration Studio
for IXXAT CME/PN and a IXXAT CME/PN gateway. See also the help page on network interface configuration.

The desired download interface may be selected via the Download Interface combo box. The Configure button opens
the Interface Configuration dialog of the currently selected interface. The file that shall be downloaded is selected via
the ellipsis button ( ). CANopen Configuration Studio for IXXAT CME/PN currently supports *.profinetcdc files (for
generated configuration data) and *.bin files (for firmware updates).

Only a binary file supplied by IXXAT shall be selected for a firmware update.

The HOST LED of the IXXAT CME/PN is permanently RED during the download process.  After the download
process the HOST LED is off until the boot process is finished. A firmware update may take 1-2 minutes to
complete. Note that the progress bar pauses some time before indicating the first update progress. Do not
interrupt the IXXAT CME/PN power supply during the download process.

The download is controlled by the buttons at the bottom of the dialog. Download starts the download of the selected
file using the selected interface. While the download is running the progress bar will indicate the current status. A
running download may be aborted by means of the abort button.

After the download, a message box confirms the successful completion of the procedure. Click OK and then Close to
close the dialog.

54 CANopen Configuration Studio for IXXAT CME/PN

©2015 IXXAT Automation GmbH. All Rights Reserved.



Download via direct USB Link to a IXXAT CME/PN

USB does not have special options that may be selected from within the Download dialog.

USB Download dialog
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4.4.3 Device Catalog Management
The Device Catalog Management dialog is used for configuration of the devices available in the catalog. The dialog is
available via the Tools→Manage Catalog menu item. Only devices that have been imported into the device catalog
may be used in projects. The dialog is related to the Device Catalog tool window.

Device Catalog Management dialog
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Within the list of imported devices, the following information is displayed if available in the electronic data sheet for
the device. If the data cannot be extracted from the device data, the corresponding column is left empty.

Column Description

Multi-purpose column that contains the vendor name, a textual description of the
additional information field in 1000h Device type. The nodes may be ordered by

manufacturer or device profile.

Description The value of the description field of the [FileInfo] section in the EDS file.

Vendor-ID Vendor-ID as assigned by CAN in Automation, contained in object 1018h sub-index

01h.

Product Code Manufacturer specific product code, contained in object 1018h sub-index 02h.

Revision Number Manufacturer specific revision number, contained in object 1018h sub-index 03h.

Hardware Version Hardware version as contained in the electronic data sheet for the device. The value
presented in the list is extracted from object 1009h Manufacturer hardware

version.

Software Version Software version as contained in the electronic data sheet for the device. The value
presented in the list is extracted from object 100Ah Manufacturer software

version.

RPDOs Number of receive PDOs supported by the device.

TPDOs Number of transmit PDOs supported by the device.

Granularity The granularity value defined in the [DeviceInfo] section of the EDS.

Group Messaging Indicates if the device support group messaging.

File Version The file version according the [FileInfo] section of the EDS.

Modification Date & Time The date and time of the last modification of the EDS file.

File The original file name of the EDS file.

At the lower border of the dialog an output and an error window are docked that display errors, warnings and
information created during device import.
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Menu system

File (keyboard accelerator: Alt+F)

The File menu contains commands basic commands.

Icon Command Keyboard shortcut Keyboard accelerator

 Close   Alt+F,C

Edit (keyboard accelerator: Alt+E)

Commands for importing or removing devices from the catalog.

Icon Command Keyboard shortcut Keyboard accelerator

 Import Device  Alt+E, I

 Remove Device  Alt+E, R

Toolbar

The toolbar implements the interface to commands that sort the devices and add or remove devices.

Icon Description

If this tool bar item is clicked the device tree is sorted by device profile at the first level.

If this tool bar item is clicked the device tree is sorted by device vendor at the first level.

Imports a new device to the catalog. Opens a file open dialog for EDS files.

Removes the currently selected device from the catalog.
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4.4.4 Options
The Options dialog contains all global options of the application. The dialog is available via the Tools→Options menu
item.

CANopen Configuration Studio for IXXAT CME/PN Options dialog
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Group Sub-Group Option Description

General Files & Paths Default Project Directory The default path
CANopen
Configuration Studio
for IXXAT CME/PN
will propose if
projects are saved or
loaded.

Default EDS Directory The default path the
application will
search for EDS files.

Startup Show Splash Screen on Startup If checked the splash
screen will be shown
on startup.

Network Access PROFINET USB Download Download Timeout Default timeout used
for a down
operation.

Firmware Update Timeout Default timeout used
for a firmware
update operation. As
firmware update
requires some long
running internal
operations, the
timeout is higher
than the normal
download timeout.
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4.5
CANopen Configuration Studio for IXXAT CME/PN
Workspace Customization

The user interface of CANopen Configuration Studio for IXXAT CME/PN is fully customizable. Customization may
involve hiding or displaying, floating or docking tool windows, or arranging the workspace tab pages in individual
horizontal or vertical groups.

Tool windows are used for network topology definition and device specific configuration tasks. The following tool
window states are supported:

Floating Tool windows may be freely positioned on the desktop, also in front of other
windows.

Dockable The tool window is in either docked or floating state. If in floating state it may be freely
positioned on the desktop, but also may be attached to the main application window.

Tabbed Document This option is only available for the Project Explorer tool window. The tool window is
available as an additional tab page in the central workspace area. If in tabbed state, the
tool window may be set to any other state using the context menu on the tab page
header.

Auto-Hide The tool window may be unpinned to enter the auto-hide state. A tab appears for each
tool window that is unpinned. As soon as a tool window looses focus it is minimized.
As the mouse pointer moves over a tab, the corresponding tool window and its
content is redisplayed.

Hide The control is hidden from the user. This state is equal to the control being closed. To
redisplay the control select the corresponding menu item under the View menu in the
main menu bar of the application.

The default state of tool windows is docked to the main application window.

Tool Window Context Menu

For tool windows, the available menu options are accessible via the context menu (see figure below) which opens on
right-click on the window title bar or by clicking the tool window pull down menu icon 

CANopen Configuration Studio for IXXAT CME/PN 61

©2015 IXXAT Automation GmbH. All Rights Reserved.



Tool Window Control Icons

The title bar of a tool window contains the following icons to control the window state:

Icon Description

Opens the tool window context menu.

Tool windows with docking buttons may be hidden at the border of the CANopen Configuration Studio for
IXXAT CME/PN main application window. Press the button in the upper left corner of the tool windows title
bar. The tool window will be represented by a tab at the nearest border of the CANopen Configuration
Studio for IXXAT CME/PN main application window.

If a tool window is in auto-hide state, press the button to un-hide the tool window again.

Press this button to close a tool window. The tool window may be made visible again by selecting the
corresponding menu item in the View menu.

Docking Guides

Verify that the menu item Dockable is checked in the tool window context menu. While dragging tool windows, dock
guides are displayed to indicate valid drop locations. A preview of where the window is to be placed is shown when
the mouse is hovered over a single dock guide.

When dragging tool windows while holding the Control key down dock guides are not displayed and the tool
window will be floating when the mouse pointer is released.
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5
CANopen Configuration Studio for IXXAT CME/PN
Configuration Examples

The tutorials that are part of this chapter give short step by step instructions how to create CANopen network projects
with the CANopen Configuration Studio for IXXAT CME/PN.

Creating a CANopen configuration involves creating an empty project, populating the project with devices, selection
of application objects that are to be mapped into the process image of the IXXAT CME/PN, setting up NMT error
control, and finally generating and downloading the configuration data into the IXXAT CME/PN.

The examples in the following sections are based on a network topology similar to that described in the introduction
to this online help.

Example Demonstrated functionality

Creating a CANopen
project and basic network
configuration

Create a new CANopen project
Working with the CANopen device catalog
Selection of application objects to be mapped into the process image of the
CANopen managing device
Configuration of NMT error control
Configuration of CANopen and PROFINET timing parameters
Generate and download the CANopen configuration

Integrating the configured
IXXAT CME/PN device into
a PROFINET network

Select the PLC hardware
Add the GSDML file (generated by CANopen Configuration Studio for IXXAT
CME/PN) to the SIMATIC STEP 7 device catalog
Add and configure the IXXAT CME/PN
Work in online mode
Use of CANopen SDO services

Note that the examples presented here use device description information from EDS files that have been
compiled based on the published CiA specifications. These files do not necessarily correspond to EDS files
describing commercially available CANopen devices.

CANopen Configuration Studio for IXXAT CME/PN generates configuration data that may be downloaded into
the IXXAT CME/PN gateway only for those objects in the CANopen devices for which the configured value
differs from the default value as declared in the device description files. If the device description files used to
generate the configuration do not exactly match the functionality of the devices used to implement the
CANopen network, the configuration data may be successfully downloaded into IXXAT CME/PN, however after
having started the CANopen network, the devices may not operate as intended.
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5.1 Basic CANopen Network Configuration
This tutorial gives a short step by step introduction in how to create a simple CANopen network project with
CANopen Configuration Studio for IXXAT CME/PN. The project described in this section is composed of three CiA 401
compliant I/O modules and one IXXAT CME/PN PROFINET to CANopen gateway device.

1. Create a new CANopen network project with CANopen Configuration Studio for IXXAT CME/PN
2. Configuration of the byte order representation of the IXXAT CME/PN process image
3. Add CANopen slave devices to the project
4. Selection of the application objects to be mapped into the process image of the IXXAT CME/PN
5. PDO calculation and inspection of the process image layout
6. Configuration of NMT error control functionality
7. Configuration of CANopen and PROFINET timing parameters
8. Generation of CANopen configuration data
9. Download of configuration data to a IXXAT CME/PN gateway
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5.1.1 Create a new Project
To prepare a new configuration for a IXXAT CME/PN by IXXAT Automation GmbH, start CANopen Configuration
Studio for IXXAT CME/PN and create a new project. To create a new project, either select the File→New menu item or
use the Ctrl+N or Alt+F, N keyboard shortcuts or accelerators. This operation will open the New Project dialog.

New Project dialog
 

In the dialog the user needs to specify where to save the project. The default path for CANopen Configuration Studio
for IXXAT CME/PN is set to C:\Users\Public\Public Documents\IXXAT\CANopen Configuration
Studio for IXXAT CME-PN on English locale Windows 7 systems. Use Example network as name for our first
project.

Next we need to specify the type of CANopen manager device that shall be used for this project. Click on the Browse
button and select IXXAT CME/PN from the list of available manager devices.

We also need to specify the node-ID of the CANopen manager device in the network. We leave this at the default
value of 127.

Finally the maximum sizes of process image OUT and process image IN have to be specified. The process image is the
buffer where process data are stored in the CANopen manager and from where the process data are exchanged with
the PROFINET network. CANopen Configuration Studio for IXXAT CME/PN uses the values hard-coded in IXXAT
CME/PN to check that no more application objects are selected than supported by the IXXAT CME/PN.

Closing the New Project dialog now with OK will create an empty new project containing the IXXAT CME/PN module
as managing device with node-ID 127.
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New project populated with only the IXXAT CME/PN
 

We have now concluded the first step in the generation of a CANopen network configuration for the IXXAT CME/PN
gateway. We can now continue to add devices to the CANopen network.
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5.1.2
Byte Order Representation of the IXXAT CME/PN
Process Image

PROFINET and CANopen use different network byte order conventions to transfer multi-byte data objects. PROFINET
by default uses the big endian format, CANopen uses the little endian format in which the lowest order byte is
transferred first in the CAN frame.

The example below illustrates how an UNSIGNED32 value 01020304h will be transmitted over the PROFINET and the
CANopen networks.

By default IXXAT CME/PN swaps bytes in a multi-byte object such as INTEGER32 so that in the process image those
objects are stored in big endian format, allowing for easier processing by PROFINET IO devices. This byte swapping is
only supported for numerical data objects that are transmitted with PDO services. Automatic byte swapping is not
possible for SDO services as this CANopen protocol provides no intrinsic possibility to distinguish between numeric
data objects and streams such as VISIBLE_STRING or DOMAIN type objects.

This requires different handling for data objects depending on if they are transmitted via SDO services or via the
process image and PDO services. It has to be ensured that data objects that are to be transmitted using SDO services
are provided in little endian format. IXXAT CME/PN may be alternatively configured such that data in the process
image are stored in little endian format as well. This however necessitates that data objects located in the process
image of IXXAT CME/PN are transmitted in little endian format by the PROFINET IO controller. Data have therefore to
be converted into little endian format on the PROFINET IO controller.

The configuration for big endian or little endian handling may be parameterized in object 4000h of the IXXAT
CME/PN. To modify the default value, select the IXXAT CME/PN node in the Project Explorer of CANopen
Configuration Studio for IXXAT CME/PN and navigate to object 4000h in the Device Parameters tool window. Enter a
configuration value in the Value column according to your requirements.
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Configuration of the process image byte order
 

5.1.3 Add Devices to the Project
After an empty project has been created in CANopen Configuration Studio for IXXAT CME/PN slave devices can be
added to the network. In this example one of the CANopen slave device templates that are included in the device
catalog by default is used, but it can be any other type of CANopen device that has been added to the device catalog
prior to this step.

To use any other device, the corresponding device description file (EDS) for this device has to be imported into the
device catalog.

To add a device to the CANopen network, open the corresponding navigation pane in the Device Catalog tool
window, select the device that shall be added to the network description and drag it to the Project Explorer window
and drop it there.

For each device a logical name has to be assigned, allowing the user to distinguish between different devices of
identical type. It is also required to specify the CANopen node-ID for the device and a group to which the device will
be added. The user may also enter a textual description of the device's functionality in the Description field.
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Add a new device to the CANopen project
 

When the dialog is closed with OK, the device is added to the Project Explorer window:

CANopen project populated with a CANopen manager and one CANopen slave I/O device
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Repeat this operation to add two more I/O devices to the project. The Project Explorer will display the following
project structure with one CANopen manager device and three I/O modules:

CANopen project populated with a CANopen manager and three CANopen slave I/O devices
 

Now that we have described the composition of the network, we can continue to select the process data that shall be
exchanged between the CANopen manager and the slave devices.
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5.1.3.1 Import CANopen Devices to the Device Catalog
If it is required to integrate additional devices into a CANopen network to configure them with CANopen
Configuration Studio for IXXAT CME/PN, their device description information has to be imported into the device
catalog first.

To do this, the corresponding EDS files are required. Those files are either shipped with the devices or available from
the WWW pages of the device vendor. In the example the description for an Anybus-S module by HMS Industrial
Networks is imported into the device catalog.

Selection of an EDS device description file
 

This adds the device to the device catalog. It can now be used in CANopen Configuration Studio for IXXAT CME/PN
projects.
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5.1.4 Selection of Process Data
To select the process data of the CANopen slave devices that shall be mapped into the process image on the IXXAT
CME/PN, navigate to the Application Objects workspace page. On this page, a list of all the application objects that
are mappable as process data is displayed. The application objects are sorted according to the node-ID of the device,
their object index, and finally the sub-index of the entry.

Select individual application objects

To select application objects, click the checkbox in the Mapped column next to the parameter name. In the example
below the first four digital input blocks of the CANopen I/O module 1 (object dictionary index 6000h, sub-index range
01h to 04h ) have been selected.

Selection of individual application objects for mapping into the process image of the IXXAT CME/PN
 

The buffer size allocated in the process image on the IXXAT CME/PN gateway can be simultaneously monitored in the
application objects toolbar. As we have selected four UNSIGNED8 input objects, we see that 4 bytes are allocated in
the process image. In the notation used by CANopen Configuration Studio for IXXAT CME/PN, IN denotes input
objects on the CANopen slave devices, OUT denotes output objects on the slaves.

Current allocation status for process image IN and OUT
 

To verify the configuration of the PDO communication based on this object selection, navigate to the Build menu and
select Calculate Configuration. This creates a structure with four new network variables in the process image on the
IXXAT CME/PN gateway.
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To inspect the resulting PDO configuration on the devices with node-ID 1 (I/O module) and node-ID 127 (IXXAT
CME/PN) select the devices in the Project Explorer. In the PDO Parameters tool window we find that four network
variables with object index A4C0h, sub-indices 01h to 04h are mapped into RPDO1 on the IXXAT CME/PN gateway.

PDO mapping configuration for TPDO1 on node-ID 01h
 

PDO mapping configuration for RPDO1 on node-ID 7Fh
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Repeat this operation for the other two I/O modules in the example network such that for each I/O module 4 digital
input blocks are mapped. For I/O module 1 additionally select 2 digital output blocks (object dictionary index 6200h,
sub-index 01h and 02h), 2 analog input channels (object dictionary index 6401h, sub-index 01h and 02h), and 2
analog output channels (object dictionary index 6411h, sub-index 01h and 02h). A recalculation will result in the
following PDO configuration on the IXXAT CME/PN gateway.

Final PDO mapping on the IXXAT CME/PN
 

Continue now with and inspection of the resulting process image layout.
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5.1.5 Inspection of the Process Image Layout
To see the resulting process image on the IXXAT CME/PN gateway after the calculation process, navigate to the
Process Image workspace page. We see that we have created 14 input variables  and 4 output variables . Their
exact offset in the process images IN and OUT is listed in the Address column ,  on the right.

Resulting process image layout on the IXXAT CME/PN after calculation of the PDO configuration
 

Columns in the process image list may be freely reordered, thus the actual layout in your installation may differ
from the screen dump pictured above.

Before we download the configuration to the IXXAT CME/PN gateway, we will setup device monitoring via CANopen
NMT error control to detect device failures, or changes the NMT state that were not explicitly triggered by the NMT
master in the network.

5.1.6 Configuration of NMT Error Control
With CANopen Configuration Studio for IXXAT CME/PN, the setup of the CANopen error control functionality is
performed in the Error Control Configuration workspace page, in which the so called heartbeat parameters can be
specified. Heartbeat is one of the two error control mechanisms specified by CAN in Automation in CiA 301. CiA
recommends to use the heartbeat mechanism instead of the alternative node guarding protocol.

Configuration entries for heartbeat or node guarding
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In the Producer Time column, we can configure how often we want the I/O module and the IXXAT
CME/PN gateway to transmit heartbeat messages to indicate that they are operating as expected. In the example
below, this is set to 500 milliseconds.

We also need to specify the heartbeat consumer time which is the time frame in which the receiving device expects a
heartbeat message from the producer. For the I/O module 1, we click into the Consumer Time cell in the list. This will
display an ellipsis button. If we click this button a list containing all available entries in the Consumer heartbeat time
list on node-ID 1 will open.

In this list, we specify that I/O module 1 shall expect heartbeat messages from the IXXAT CME/PN, which is using
node-ID 127, once every 1000 milliseconds. If the I/O module does not receive a corresponding heartbeat message
from the IXXAT CME/PN, it will transmit an emergency message.

According to CiA 301, heartbeat is an optional functionality. CANopen requires only that either heartbeat or
node guarding shall be supported. If heartbeat is not implemented by a device, N/A will be displayed in the
corresponding list cells. It is not mandatory to activate either heartbeat or node guarding.

Configuration of object 1016h Consumer heartbeat on I/O module 1
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We repeat this configuration step for the other I/O modules and IXXAT CME/PN device, such that it expects a
heartbeat message from the I/O module with node-ID 1, 2, and 3 once every 1000 milliseconds.

Configuration of object 1016h Consumer heartbeat on the IXXAT CME/PN
 

We have now concluded our configuration and can continue to adjust the timing parameters for the IXXAT CME/PN
module.
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5.1.7
Configuration of CANopen and PROFINET Timing
Parameters

The setup of the IXXAT CME/PN timing parameters is performed in the Timing Parameters workspace page
of CANopen Configuration Studio for IXXAT CME/PN. Two combo boxes support the specification of CANopen bit
rate and PROFINET update time.

Select the CANopen bit rate first, for example 125 kBit/s. Then select the PROFINET update time less or equal to half
of the shortest process data duration. Based on the configured parameters CANopen Configuration Studio calculates
the PDO payload and estimates the total PDO transmission time.

If the estimated PDO transmission time is in the recommend range your selection will work even if all configured
TPDOs and RPDOs are transmitted once during the PROFINET update time. You may now continue with the next step.

If the estimated PDO transmission time is out of the recommended range a warning icon will be displayed behind the
total PDO transmission time field. In that case you should adjust the current settings. The following options are
suggested:

Select a higher CANopen bit rate to shorten the estimated PDO transmission time until the warning icon
disappears.
Select a slower PROFINET update time to reduce the frequency of PDO bursts. As a consequence the warning
icon will disappear.
 

The PROFINET update time must be less or equal to half of the shortest process data duration.

 
Ignore the warning icon if you have reliable information about the real PDO transmission time of your process
and if this time is lower than the PROFINET update time.

Additional information is provided in the page on IXXAT CME/PN Timing Parameters

5.1.8 Generation of Configuration Data
Before the configuration can be downloaded to the IXXAT CME/PN gateway, the configuration data for the CANopen
network have to be generated. This is performed by selecting Generate Configuration from the Build menu or the
corresponding toolbar button. We save the generated configuration data into the same folder as our example
network project.

78 CANopen Configuration Studio for IXXAT CME/PN

©2015 IXXAT Automation GmbH. All Rights Reserved.



Selection of the device configuration file into which the network configuration data are written
 

This concludes the configuration and we can now download the configuration data to the IXXAT CME/PN gateway.

5.1.9 Download to the IXXAT CME/PN
Before starting the download it is required to specify the interface that will be used to transfer the configuration data
to the IXXAT CME/PN. This may be performed via selecting the Network→Interface Configuration menu item or the
corresponding toolbar button ( ) or directly from within the Download dialog via the Configure... button.

In this case the PC running CANopen Configuration Studio for IXXAT CME/PN is connected to the IXXAT CME/PN
gateway via a USB cable.

If several IXXAT CME/PN devices are connected to the host PC, we need to select the module we want to download
the configuration to.

Finally, we need to select the configuration file generated earlier and start the download process.

We have now generated and downloaded a simple CANopen configuration to the IXXAT CME/PN gateway. This step
concludes the first tutorial.
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5.2 IXXAT CME/PN in a PROFINET Network
The subsequent sections demonstrate the integration of a CANopen network into a PROFINET system with the help of
the IXXAT CME/PN gateway. The examples use the SIMATIC STEP 7 engineering software and SIMATIC S7-300 PLC as
PROFINET IO controller.

The chapter is subdivided into:

1. Integration of the IXXAT CME/PN gateway into the SIMATIC STEP 7 project
2. Using the command and diagnostics interface

5.2.1
Integration of IXXAT CME/PN into the
SIMATIC STEP 7 project

The following sections demonstrate how to integrate a configured IXXAT CME/PN into a PROFINET network. The
example uses a SIMATIC S7-300 PLC as PROFINET IO controller. The system is configured with the SIMATIC STEP 7
engineering tool. The example covers the following steps:

1. Creating a new SIMATIC STEP 7 project
2. Configuration of the SIMATIC S7-300 PLC
3. Add the PROFINET device description for the configured IXXAT CME/PN gateway to the SIMATIC STEP 7 device

catalog
4. Add the IXXAT CME/PN gateway to the PROFINET IO system
5. Set IP configuration and assign device name to IXXAT CME/PN
6. Add S7 Program Blocks
7. Compile and Download to the SIMATIC S7-300 PLC
8. Working with the SIMATIC S7-300 PLC and the IXXAT CME/PN in online mode
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5.2.1.1 Creating a SIMATIC STEP 7 Project
To create a new SIMATIC S7 project open the SIMATIC Manager from the Windows start menu. The SIMATIC Manager
is typically installed in the SIEMENS Automation→SIMATIC program group.

SIMATIC Manager
 

CANopen Configuration Studio for IXXAT CME/PN 81

©2015 IXXAT Automation GmbH. All Rights Reserved.



Open the New Project dialog with the File→New... menu item or the corresponding toolbar button and enter
Example1 as project name.

New Project dialog of the SIMATIC Manager
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Empty Example1 SIMATIC project
 

Now that an empty SIMATIC STEP 7 project has been created, we continue to specify the SIMATIC S7-300 CPU unit
and the PROFINET configuration to which we will connect the IXXAT CME/PN.
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5.2.1.2 Configuration of the SIMATIC S7-300 PLC
In the first step of the definition of the PLC setup a SIMATIC station is inserted into the Example1 project. Select
Insert→Station→SIMATIC 300 Station from the main menu of the SIMATIC Manager.

Insert SIMATIC 300 station
 

This adds one new SIMATIC 300 station to the project.

84 CANopen Configuration Studio for IXXAT CME/PN

©2015 IXXAT Automation GmbH. All Rights Reserved.



Example1 project with SIMATIC 300 station
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Opening the SIMATIC 300 object via the context menu, with the keyboard shortcut Ctrl+Alt+O, or by double-clicking
the Hardware icon in the project will start the HW Config window the allows further configuration of the SIMATIC 300
station.

Hardware configuration windows of the SIMATIC STEP 7 software
 

Proceed in the following sequence:

1. In the hardware catalog, expand the SIMATIC 300 node ( ) and then expand the RACK-300 node. Drag the
Rail icon ( ) and drop it in the configuration window.

2. In the hardware catalog, expand the SIMATIC 300 node ( ) and then expand the CPU-300 node. Expand the
node that corresponds to CPU type used in your setup and drag the icon corresponding to the exact CPU
version used ( ) and drop it in slot 2 of the rail previously added in step 1. In the case of the example
demonstrated here this is a CPU 317-2 PN/DP → 6ES7 317-2EK13-0AB0 → V2.6.

3. When the CPU is dropped onto the rail a configuration dialog is displayed that requests the user to specify the
IP address of the PN-IO interface.
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Properties of the PN-IO interface
 

For this example enter 192.168.99.1 and retail the subnet mask 255.255.255.0. Press New... to open the dialog
to set the properties of the new industrial Ethernet subnet.
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SIMATIC STEP 7 hardware configuration with CPU 317-2 PN/DP CPU and PROFINET IO system
 

Continue now to add the PROFINET device description for the Example1 IXXAT CME/PN project to the hardware
catalog.
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5.2.1.3 Add the PROFINET Device Description
In the hardware configuration window select Options→Install GSD File... from the main menu.

Open the Insert GSD Files dialog
 

In the dialog, navigate to the directory in your file system where the GSD file created in the Example1 has been saved.
Select the corresponding XML file and click Install. The file name of the GSD file is composed according to the PNO
GSDML specification:

1. "GSDML"
2. The version ID in format Vx.y whereby "x" and "y" are unsigned numbers. The version ID refers to the ID of the

GSDML schema used. IXXAT CME/PN is based on version 2.3.
3. Vendor name, here "IXXAT"
4. Device family name. To distinguish between multiple projects, the name of the CANopen project is used. In our

case this is "Example1"
5. Release date of the GSD in format yyyymmdd
6. Release time of the GSD in format hhmmss. "hh" is "00" up to "24". The indication of the release time is

optional but used by IXXAT Automation GmbH
7. ".xml" (file extension)

For the example project the file name of the GSDML file is thus GSDML-V2.3-IXXAT-Example1-20131022-
234911.xml.
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Selection of the GSD file to be inserted into the hardware catalog
 

Close the dialog and navigate to the hardware catalog. The IXXAT CME/PN device will be installed under the category
PROFINET IO→Additional Field Devices→Gateway→IXXAT CME/PN.
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SIMATIC STEP 7 hardware catalog with the IXXAT CME/PN GSD added to the list of available devices
 

Under the IXXAT CME/PN device we also find categories for input and output. Opening these categories we identify
exactly those application objects of the CANopen slaves devices that have been added to the process image of the
CANopen manager on the IXXAT CME/PN during the prior CANopen network configuration. As naming convention
CANopen Configuration Studio for IXXAT CME/PN uses a concatenation of the CANopen devices' node-ID, the object
index and sub-index, and the parameter entry name.

Example:

01_6000_01_Read_input_01h_to_08h

Node-ID of the remote CANopen slave 01

Object index 6000

Object sub-index 01

Parameter name Read_input_01h_to_08h

We continue to add the IXXAT CME/PN gateway to the PROFINET IO system in our SIMATIC STEP 7 project.
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5.2.1.4
Add the IXXAT CME/PN Gateway to the PROFINET
IO System

In the hardware catalog, expand the PROFINET IO→Additional Field Devices→Gateway→IXXAT CME/PN category in
the device tree. Select the node corresponding to the previously created example project, drag it into your SIMATIC
300 configuration and drop it onto the PROFINET IO system.

SIMATIC 300 configuration with IXXAT CME/PN added to the PROFINET IO system. CANopen application
objects are entered in slots under the IXXAT CME/PN
 

The gateway modules are automatically entered into the correct slots. In the slots, the module names are truncated to
a total of 24 characters each.
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The next step verifies the configuration of the IXXAT CME/PN gateway. Double-click the CME/PN icon in the
configuration window to open the IXXAT-CME-PN properties dialog. Check device name (IXXAT-CME-PN) and IP
address (192.168.99.2, the next available address in the PROFINET IO subnet of the CPU) and click OK to confirm the
settings.

IXXAT CME/PN properties dialog
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In the final step of the offline hardware configuration in the HW Config window select Station→Save and Compile.

Save and compile the hardware configuration in the HW Config window
 

We continue to configure the IXXAT CME/PN IP address and device name.
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5.2.1.5
Set IP Configuration and assign Device Name to
IXXAT CME/PN

We now have defined a PROFINET topology in STEP 7 consisting of SIMATIC S7-300 PLC as PROFINET IO controller
and IXXAT CME/PN as PROFINET IO device. We also need to parameterize the IXXAT CME/PN device such that it
corresponds to the projected STEP 7 configuration. In factory settings, IXXAT CME/PN is shipped with the IP address
set to 0.0.0.0 and an empty device name. For this step, verify that SIMATIC S7-300 and IXXAT CME/PN are powered
and connected as depicted in the introductory section on example 1. Return to the SIMATIC Manager and select
PLC→Edit Ethernet Node... from the main menu.

Open the Edit Ethernet Node dialog to assign IP address and device name
 

CANopen Configuration Studio for IXXAT CME/PN 95

©2015 IXXAT Automation GmbH. All Rights Reserved.



In the Browse Network dialog browse for accessible nodes and select the IXXAT CME/PN.

Browse for accessible Ethernet nodes. Select the line with the device type IXXAT CME/PN
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In the Edit Ethernet Node dialog enter IP address and subnet mask in the Set IP configuration group. Press Assign IP
Configuration. Also assign the device name.

Make sure that the IP address and device name correspond exactly to IP address and device name set in the
properties dialog of the hardware configuration.

Edit Ethernet Node dialog. Assign IP address, subnet mask, and device name
 

The basic configuration steps are now finalized. In the next section we add required S7 program blocks to the PLC
program.
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5.2.1.6 Add S7 Program Blocks
Compiling the S7-300 hardware configuration automatically creates the program cycle organization block OB1. This
block is required to execute the user program in the S7 CPU. OB1 is executed periodically by the operating system of
the S7 CPU.

To successfully operate IXXAT CME/PN with a SIMATIC S7 CPU, organization blocks OB83 and OB86 have to be
created in addition. OB83 and OB86 are required by the Return of submodule alarm which is mandatory
according to the PROFINET specification. For further information on OB83 and OB86 consult the SIMATIC STEP 7
documentation or the online help of the SIMATIC manager.

To create OB83 and OB86 navigate to the SIMATIC Manager window and expand the SIMATIC300(1) node. Under
CPU317-2 PN/DP→S7 Program right-click on Blocks and select Insert New Object→Organization Block. In the dialog
enter OB83 in the Name text field and confirm. Repeat this for OB86.

SIMATIC Manager window with required organization blocks OB83 and OB86
 

We continue to compile and download the hardware configuration and the STEP 7 program into the SIMATIC S7-300
PLC.
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USB:

Ethernet:

5.2.1.7 Compile and Download to S7-300
Prior to downloading the hardware configuration and the STEP 7 program the CANopen network
configuration has to be downloaded into the IXXAT CME/PN device. This configuration must match the GSDML
file used to implement the PROFINET configuration.

Download of the CANopen network configuration is supported via USB or via Ethernet:

Download from within CANopen Configuration Studio for IXXAT CME/PN. For details on the
CANopen configuration download see the sections Download of Configuration Data
or Download to the IXXAT CME/PN. Then proceed with the compilation of the hardware
configuration and the STEP 7 program.

Download from the SIMATIC HW Config window.

We continue with the compilation of the hardware configuration and the STEP 7 program. In the SIMATIC Manager
window, select the SIMATIC S300(1) node in the Example1 tree and then in the menu system select PLC→Compile and
Download Objects...

Compile and Download Objects
 

In the compile and Download Objects dialog, select the Compile only checkbox and select all objects. Start the
compilation with the Start button. On completion close this dialog.
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Compile and Download dialog
 

Finally download the hardware configuration and the STEP 7 program into the S7-300 PLC. In the SIMATIC Manager
window, select the SIMATIC S300(1) node in the Example1 tree and then in the menu system select PLC→Download.

We use the menu item PLC→Download for the download. Other than the menu item PLC→Compile and
Download Objects... this menu item enforces the download of all objects.
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Download the compiled configuration into the S7-300 PLC from the SIMATIC Manager window
 

The SIMATIC Manager will request if the current system data in the programmable controller shall be deleted and
replaced with the offline system data, if the target module shall be stopped, and if the blocks OB1. OB83, and OB86
shall be overwritten. Confirm with Yes.

When the download has been completed we proceed with sending and receiving data in online mode.

5.2.1.7.1 Download from SIMATIC HW Config
In the HW Config window select the IXXAT CME/PN device that shall be configured.

It is possible to add several IXXAT CME/PN gateways to the PROFINET IO System, see the section Add the IXXAT
CME/PN Gateway to the PROFINET IO System. It has to be taken care to select the correct IXXAT CME/PN device
for which the configuration has been generated.

Open the context menu of the selected IXXAT CME/PN with a right mouse click. Select Start Device
Tool→Configuration Downloader. The Download dialog that will be opened supports the selection of *.profinetcdc
files (for generated configuration data) and *.bin files (for firmware updates).
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Opening the Download dialog from the SIMATIC HW Config window
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IXXAT CME/PN device tool download dialog
 

Only binary files supplied by IXXAT shall be selected for a firmware update. If an invalid firmware update file is
loaded via Ethernet both LEDs S1 and S2 will blink red. In this case the device must be power cycled. Afterwards
the device will be operational again. If a valid firmware update file is loaded the HOST LED of the IXXAT CME/PN
will be permanently RED during the download process. After the download process the HOST LED will be off
until the boot process is finished. A firmware update may take 1 to 2 minutes to complete. Note that the
progress bar pauses some time before indicating the first update progress. Do not interrupt the IXXAT CME/PN
power supply during the download process.

The download is controlled by the buttons at the bottom of the dialog. Download starts the download of the selected
file to the selected IXXAT CME/PN device. While the download is running the progress bar will indicate the current
status. A running download may be aborted by means of the abort button. After the download, a message box
confirms the successful completion of the procedure. Click OK and then Close to close the dialog.

5.2.1.8 Working in Online Mode
If the values of bit 2 NMT master start and bit 3 Start node of object 1F80h NMT startup are set to 0
in the CANopen configuration, the CANopen manager in the IXXAT CME/PN gateway will configure the
CANopen slave devices and start the network. This implies that all devices will be set to NMT state Operational.

 

IXXAT CME/PN sets the network to NMT state Operational only if communication over PROFINET between the
SIMATIC S7-300 and the gateway has been established. If the attached CANopen devices remain in NMT state
Pre-operational (this may be monitored with a CAN bus analyzer), verify the correct configuration of both the
SIMATIC S7-300 and IXXAT CME/PN devices.
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Since the download process will temporarily interrupt the connection between PLC and gateway (LED S2
switches temporarily to red on) a CANopen manager that is already in NMT state Operational will detect an
error condition and set the CANopen network to NMT state Pre-operational. In this case the CANopen network
has to be restarted explicitly.

Methods to restart the CANopen network:

Power cycle the IXXAT CME/PN gateway
Restart the CANopen network using the CANopen SDO example program

Next verify the status of the LEDs on both the PLC and the IXXAT CME/PN gateway.

As soon as the communication over PROFINET between the SIMATIC S7-300 PLC and the gateway has been
established the IXXAT CME/PN sends valid data to the PLC. The valid data are set to 0 until data from the
CANopen network replace it.

LEDs of the PLC

If all steps described earlier have been successfully executed, the LED on the CPU module of the PLC should exhibit
the LED pattern as indicated in the nominal LED status column in the table below. For additional information, consult
the documentation shipped with the SIMATIC S-7 300 PLC.

LED Color Status Description Nominal LED
Status

BF 1 Red Bus error at the first interface (X1) Off

BF 2 Red Bus error at the second interface (X2) Off

SF Red Hardware fault or software error Off

DC5V Green 5 V power supply for the CPU and S7-300 bus On

FRCE Yellow On Active force job Off

Flashing at 2 Hz Node flash test function

RUN Green On CPU in RUN On

Flashing at 2 Hz CPU executes startup

Flashing at 0.5 Hz CPU in Stop mode

STOP Yellow On CPU in STOP or HOLD, or STARTUP mode Off

Flashing at 2 Hz CPU executes reset

Flashing at 0.5 Hz CPU executes memory reset

LEDs of the IXXAT CME/PN gateway

The CANopen LEDs on IXXAT CME/PN are implemented according to the specifications in CiA 303-3. If the IXXAT
CME/PN has correctly started the CANopen network and all devices are in NMT state Operational, the LEDs on the
IXXAT CME/PN front panel will exhibit the LED pattern as indicated in the nominal LED status column in the table
below.
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LED Name Color Status Description Nominal LED
Status

ON Power LED - Off Fuse defective
Voltage regulation
defective
Device not connected to
power

Green on

Green On Device fully functional

S1 PROFINET status LED 1 - Off No fault Off

Green - -

Red Blinking Module identification

Red On Module fault status

S2 PROFINET status LED 2 - Off Connection (AR)
established to the
controller

Off

Green On PROFINET protocol not
initialized

Red On No connection (AR) to the
controller

HOST Host status LED - Off Gateway software is not
running, initialization

Green on

Red On Update mode for
configuration or software

Red Blinking No valid configuration
found

Red Flickering Fatal error

Green Single flash Configured and
initialized, but PROFINET
connect frame has not yet
been received

Green Flashing Normal operation,
process model not valid
or no transfer of the
process model

Green On Normal operation,
exchange of valid process
data

C1 CANopen run LED - Off Gateway software is not
running, initialization
Fatal error if HOST LED
red flickering

Green on

Green Blinking NMT state Pre-
operational
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Green Single flash NMT state Stopped

Green On NMT state Operational

C2 CANopen error LED - Off No fault
Fatal error if HOST LED
red flickering

Off

Red Blinking Invalid configuration

Red Single flash CAN warning limit
reached

Red Double flash Error control event
occurred

Red Triple flash SYNC error event
occurred

Red On CAN bus off

Now that the CANopen network is started, we can open the station in online mode. In the HW Config window select
Station→Open ONLINE.

Open the SIMATIC station in ONLINE mode

LED Name Color Status Description Nominal LED
Status
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This will open the online window for the hardware configuration of the SIMATIC 300 project.

Online window to access application objects configured into the IXXAT CME/PN process image
 

We can now monitor or modify I/O parameters of remote CANopen devices. In the ONLINE window, select the IXXAT
CME/PN device. Right-click on the module 01_6411_01_Analog_outpu~ and select select Monitor/Modify. This
will display a dialog that lists the select module, its address, and the display format. In the Modify value column enter
the process value that will be written from the SIMATIC S7 CPU via the IXXAT CME/PN gateway into the remote
CANopen device.
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Monitor/Modify dialog in ONLINE mode for an analog output object
 

Note that in CANopen data are represented in little endian coding while PROFINET uses the big endian format.
Depending on the configuration of object 4000h Process image byte order to write a 16 bit process value

of 7FFFh into the CANopen device a value of FF7Fh has to be entered in the text field. In default settings IXXAT

CME/PN converts the Litte Endian data as transmitted in the CANopen network into a big endian representation
in the process image, so that no byte swapping by the user is required.

Similarly input data from remote CANopen devices can be monitored. Open the context menu for the
01_6000_01_Read_input0~ module and in the Monitor/Modify dialog for module and press the Status value
button. This will read the current value in the process image on IXXAT CME/PN into the SIMATIC S7 CPU and the STEP
7 software. In the image below, the current process data were 55h.
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Monitor/Modify dialog in ONLINE mode for a digital input object
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5.3 Command and Diagnostics Interface
The IXXAT CME/PN gateway implements a command and diagnostics interface:

The command interface enables the user to control the CANopen manager and the remote CANopen devices.
The diagnostic interface enables the user to identify failed remote CANopen devices and to retrieve
corresponding error information.
The remote access interface enables the user to read and write any object dictionary entry of a remote
CANopen device.

The command object and the diagnostic objects are included in the object dictionary of the CANopen manager. The
user accesses the object dictionaries of both the CANopen manager and the remote CANopen devices via SDOs.

5.3.1 SDO Command Sequence
To read (SDO upload) or write (SDO download) CANopen object dictionary entries either in IXXAT CME/PN or
the remote CANopen slave device the following sequences have to be executed. The data structure used to describe
the requested SDO service is common for both upload and download services.

SDO read access sequence (read diagnostic data)

1. Fill the structure with:
a. Command = 0 (SDO read)
b. CANopen node-ID
c. Object dictionary index and sub-index
d. Number of data bytes = 0

2. Send a PROFINET record with the structure to the IXXAT CME/PN
3. Receive a PROFINET record with the structure from the IXXAT CME/PN
4. Check the error code
5. Read the data contents

SDO write access sequence (write command data)

1. Fill the structure with:
a. Command = 1 (SDO write)
b. CANopen node-ID
c. Object dictionary index and sub-index
d. Data
e. Number of data bytes

2. Send a PROFINET record with the structure to the IXXAT CME/PN
3. Receive a PROFINET record with the structure from the IXXAT CME/PN
4. Check the error code
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5.3.2 SDO Command Data Structure
 

Byte Number Content Description

0 SDO service type SDO read (upload) = 0, SDO write (download) = 1

1 CANopen node-ID Valid range 01h to 7Fh

2 Object dictionary index, low byte

3 Object dictionary index, high byte

4 Object dictionary sub-index

5 Data[0] Least significant byte

... ...

249 Data[244] Most significant byte

250 Number of data bytes 0 .. 245

251 reserved Always 00

252 Error code, least significant byte SDO abort code, for details see CiA 301
0000 0000h if no error occurred

FFFF FFFFh if SDO command interface is busy
253 Error code

254 Error code

255 Error code, most significant byte
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5.3.3 CANopen SDO Example Program
Use a PLC program to transmit PROFINET records that encapsulate SDO commands. The execution sequence and format the
of these PROFINET records are defined in the sections SDO command sequence and SDO command data structure.

The IXXAT CME/PN gateway will extract the SDO commands from the PROFINET records and access the corresponding
object dictionary entries. SDO accesses to the object dictionary of the CANopen manager are handled locally on the IXXAT
CME/PN gateway. SDO accesses to object dictionaries of remote CANopen devices are transported via the CANopen
network.

The installation of CANopen Configuration Studio for IXXAT CME/PN copies a sample project “PLC-Example”
into C:\Program Files (x86)\IXXAT\CANopen Configuration Studio for IXXAT CME-PN\Step7\PLC-
Exam  folder on your PC (path name for an English locale system). Follow the procedure below to insert the blocks and
symbols of the "PLC-Example” into your project:

1. Start SIMATIC manager
2. Select File→Open to open “PLC-Example”
3. Browse to the folder of the example PLC program
4. Select “PLC-Example” and press OK
5. Select File→Open to open your project e. g. “Example1”
6. Expand “PLC-Example” and select Blocks
7. Select all blocks of “PLC-Example”
8. Expand “Example1” and select Blocks

S7 Program Blocks of PLC Example project
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9. Drag all blocks of “PLC-Example” and drop them in “Example1”
10. Confirm overwriting of all blocks
11. Select S7 Program→Symbols in the “PLC-Example” window
12. Select S7 Program→Symbols in the “Example1” window
13. Drag Symbols of “PLC-Example” and drop them in “Example1”
14. Confirm replacing of symbols
15. Close “PLC-Example”

You may now repeat the tests of the section Working in Online Mode.

5.3.4 CANopen SDO Example Blocks
The following table gives an overview of the blocks and symbols of the project PLC-Example. The logic block OB1
internally calls first the logic block FC2 which implements SDO_START_NETWORK and then the block FC4
(SDO_GET_DEVICETYPE) for both node-ID 7Fh (CANopen manager) and 01h (I/O device). FC2 demonstrates how to
start the network by writing to object 1F82h, Request NMT, FC4 how to read object 1000h, Device type. Alternatively
you may read one of the IXXAT specific diagnostics objects in IXXAT CME/PN similar to the program code of FC4.
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Block Symbol Description

OB1 CYCL_EXC Cyclic execution of of the startup statemachine:

STATE0: Call SDO_GET_MANAGER_STATE
STATE1: Call SDO_START_NETWORK
STATE2: Call SDO_GET_DEVICETYPE
STATE3: Wait for GATEWAY_IO_READY
STATE4: Process Data IO

OB35 CYC_INT5 Cyclic interrupt

Modifies IO data every 100ms (for demonstration only)

OB83 I/O_FLT2 Monitors the presence of modules in the central rack. This block is executed
for each module when it becomes operational and its process data are valid

OB85 OBNL_FLT The operating system of the CPU calls OB85 when the following event occurs:

I/O access error during update of the process image by the system

OB86 RACK_FLT Detects a rack failure. This block is called when a PROFINET IO device fails or
when the error is eliminated. This is the case when the gateway is available
again (for example after disconnect)

OB100 COMPLETE RESTART Clear execution control flags and initialize process IO data

OB122 MOD_ERR The operating system of the CPU calls OB122 whenever an error occurs while
accessing data on the module

FC2 SDO_START_NETWORK Uses the command interface to start the CANopen network by calling FB2
(SDO_REQUEST) to write 05h (NMT state operational) to object 1F82h, sub-

index 7Fh (Request NMT)

FC3 SDO_GET_MANAGER_STATE Uses the diagnostic interface to query the CANopen manager state by calling
FB2 (SDO_REQUEST) to read object 5000h, sub-index 02h (State of the

CANopen manager)

FC4 SDO_GET_DEVICETYPE Uses the diagnostic interface to query device type of a device by calling FB2
(SDO_REQUEST) to read object 1000h, sub-index 00h (Device type)

FB2 SDO_REQUEST State machine to perform a generic SDO read/write request

States:

STATE0: init – fill the structure
STATE1: write record
STATE2: read record
STATE3: check result

Static data:

current state
record
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Block Symbol Description

DB2 SDO_ACCESS_INSTANCE Data block of FB2

SFB52 RDREC System Function Block. Read a data record from a PROFINET IO device

DB52 Data block of SFB52

SFB53 WRREC System Function Block. Transfer a data record to a PROFINET IO device

DB53 Data block of SFB53
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6 Object Dictionary Entries
CANopen Configuration Studio for IXXAT CME/PN and the example configurations and programs described in the
previous chapters refer to a number of standardized CANopen objects as well as manufacturer specific objects that
are described in more detail in the following sections.

Standardized communication profile objects
Manufacturer specific objects
Standardized device profile objects

6.1 Standardized Communication Profile Objects
CANopen Configuration Studio for IXXAT CME/PN and IXXAT CME/PN devices refer to, respectively implement,
communication objects that are standardized in the CANopen specifications published by CiA. The table below
contains a selection of those objects that can be addressed in the communication profile area of the object dictionary.

In the Implemented on device category column of the summary table below it is indicated if the
corresponding object is typically implemented on CANopen manager or CANopen slave devices or on both.
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Index Object
type

Name Data type Implemented on device
category

CiA specification

1000h VAR Device type UNSIGNED32 Manager, Slave CiA 301 and device or
application profiles

1001h VAR Error register UNSIGNED8 Manager, Slave CiA 301 and device or
application profiles

1008h VAR Manufacturer device
name

VISIBLE_STRING Manager, Slave CiA 301

1018h RECORD Identity object IDENTITY Manager, Slave CiA 301

1F80h VAR NMT startup UNSIGNED32 Manager, Slave CiA 302-2

1F81h ARRAY NMT slave
assignment

UNSIGNED32 Manager CiA 302-2

1F82h ARRAY Request NMT UNSIGNED8 Manager CiA 302-2

1F84h ARRAY Device type
identification

UNSIGNED32 Manager CiA 302-2

1F85h ARRAY Vendor
identification

UNSIGNED32 Manager CiA 302-2

1F86h ARRAY Product code UNSIGNED32 Manager CiA 302-2

1F87h ARRAY Revision number UNSIGNED32 Manager CiA 302-2

1F88h ARRAY Serial number UNSIGNED32 Manager CiA 302-2

1F89h VAR Boot time UNSIGNED32 Manager CiA 302-2
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6.1.1 Object 1000h: Device Type
This object contains information about the device type describing the type of the logical device and its functionality. It
is composed of a 16-bit field indicating the implemented device or application profile and a second 16-bit field, which
provides additional information about specific functionality of the logical device. The additional information parameter
is device or application profile specific. It is defined in the corresponding device profile and application profile
specification.

The value 0000h for the device profile number indicates a logical device that does not implement a standardized
device or application profile. In this case the additional information is 0000h if no further logical device is
implemented. For multiple logical device modules the additional information parameter is set to FFFFh and the device
profile number referenced by object 1000h indicates the profile of the first logical device in the object dictionary. All
other profiles of a multiple logical device module indicate their profiles at objects 67FFh + n × 800h with n = internal
number of the logical device (from 1 to 8) minus 1. These objects describe the device type of the preceding logical
device, having the very same value definition as object 1000h.

Structure of the device type parameter

31 16 15 0

Additional information Device profile number

MSB LSB

Object description

Attribute Value

Index 1000h

Object name Device type

Object code VAR

Data type UNSIGNED32

Category mandatory

Entry description

Attribute Value

Sub-index 00h

Access ro

PDO mapping no

Value range see value definition

Default value 0000 0000h
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6.1.2 Object 1001h: Error Register
This object provide error information. The CANopen device maps internal errors into this object. The content of the
error register is transmitted in byte 2 of an emergency object.

Value definition of the error register

Bit Mandatory/Optional Description

0 mandatory Generic error

1 optional Current

2 optional Voltage

3 optional Temperature

4 optional Communication error (overrun, error state)

6 optional Device profile specific

6 optional reserved (always 0b)

7 optional Manufacturer specific

If a specific error occurs the corresponding bit is set to 1b. The generic error bit is always supported. The other bits
may be supported. The generic error is set to 1 at any error situation.

Object description

Attribute Value

Index 1001h

Object name Error register

Object code VAR

Data type UNSIGNED8

Category mandatory

Entry description

Attribute Value

Sub-index 00h

Access ro

PDO mapping TPDO

Value range see value definition

Default value no
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6.1.3 Object 1008h: Manufacturer Device Name
This object contains a manufacturer assigned device name.

Object description

Attribute Value

Index 1008h

Object name Manufacturer device name

Object code VAR

Data type VISIBLE_STRING

Category optional

Entry description

Attribute Value

Sub-index 00h

Access const

PDO mapping no

Value range VISIBLE_STRING

Default value Manufacturer specific
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6.1.4 Object 1018h: Identity Object
This object provides general identification information of the CANopen device.

Sub-index 01h contains a value that is allocated uniquely to each vendor of a CANopen device. The value 0000
0000h indicates an invalid vendor-ID. The value is assigned exclusively by CAN in Automation.
Sub-index 02h contains a value that identifies a specific type of CANopen devices. The value of 0000 0000h is
reserved.
Sub-index 03h contains the major and the minor revision numbers of the CANopen device. The major revision
number identifies a specific CANopen behavior. That implies that if the CANopen functionality is different, the
major revision number is incremented. The minor revision number identifies different versions of a CANopen
device with the same CANopen behavior. The value of 0000 0000h is reserved.

Structure of the pre-defined error field

31 16 15 0

Major revision number Minor revision number

MSB LSB

Sub-index 04h contains a serial number that uniquely identifies a CANopen device within a product group and
a specific revision. The value of 0000 0000h is reserved.

Object description

Attribute Value

Index 1018h

Object name Identity object

Object code RECORD

Data type IDENTITY

Category mandatory

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access ro

PDO mapping no

Value range 01h - 04h

Default value Profile- or manufacturer-specific
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Attribute Value

Sub-index 01h

Description Vendor-ID

Entry category mandatory

Access ro

PDO mapping no

Value range UNSIGNED32

Default value Assigned uniquely to manufacturers by CiA

Attribute Value

Sub-index 02h

Description Product code

Entry category optional

Access ro

PDO mapping no

Value range UNSIGNED32

Default value Profile- or manufacturer-specific

Attribute Value

Sub-index 03h

Description Revision number

Entry category optional

Access ro

PDO mapping no

Value range UNSIGNED32

Default value Profile- or manufacturer-specific

Attribute Value

Sub-index 04h

Description Serial number

Entry category optional

Access ro

Access no

Value range UNSIGNED32

Default value Profile- or manufacturer-specific
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6.1.5 Object 1F80h: NMT Startup
This object configures the startup behavior of a CANopen device. Internal state transitions do not result in changes
the value of this object. An attempt to change a bit of a functionality that is not supported by the CANopen device is
responded with an abort message (abort code: 0609 0030h). The first figure below describes the overall structure of
the NMT startup object, the second figure the bit oriented structure of the configuration value. The subsequent tables
describe the allowed values.

Object 1F80h – bit structure of the value

31 24 23 16 15 8 7 0

reserved (0000 00h) Configuration

MSB LSB

Object 1F80h – bit structure of the configuration value

7 6 5 4 3 2 1 0

reserved (0b) Stop all
nodes

Flying
master

Reset all
nodes

Start node NMT master
start

Start all
nodes

NMT master

MSB LSB

Value NMT master (bit 0)

Value Description

0b CANopen device is not NMT master
The entries of the object 1F81h are ignored. All other bits of object 1F80h are ignored

1b CANopen device is the NMT master

Value Start all nodes (bit 1)

Value Description

0b NMT service start remote node is requested individually for each node-ID

1b NMT service start remote node is requested for all nodes with node-ID = 0

Value NMT master start (bit 2)

Value Description

0b The NMT master switches into NMT state Operational in the process NMT startup

1b The NMT master does not switch into the NMT state Operational by itself and wait for an
application to request the state transition into NMT state Operational
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Value Start node (bit 3)

Value Description

0b The NMT master starts the NMT slaves

1b The NMT master does not start the NMT slaves and waits for an application to request that
the NMT slaves are started

Reset all nodes (bit 4)

Value Description

0b In case of error control event of a CANopen device defined as mandatory (see object 1F81h)

the NMT service reset node with node-ID of the CANopen device that caused the error
control event is executed

1b In case of error control event of a CANopen device defined as mandatory (see object 1F81h)

the NMT service reset node with node-ID = 0 is executed

 

Note that Flying master functionality (bit 5) is not supported by IXXAT CME/PN

Flying master (bit 5)

Value Description

0b CANopen device shall not participate the NMT flying master negotiation

1b CANopen device shall participate the NMT flying master negotiation

Stop all nodes (bit 6)

Value Description

0b In case of error control event of a CANopen device defined as mandatory (see object 1F81h)

the action as defined by bit 4 is executed

1b In case of error control event of a CANopen device defined as mandatory (see object 1F81h)

the NMT service Stop remote node with node-ID = 0 is executed. Bit 4 is ignored
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Object description

Attribute Value

Index 1F80h

Object name NMT startup

Object code VAR

Data type UNSIGNED32

Category conditional
mandatory if the CANopen device is a CANopen manager or a start-up capable CANopen
device

Entry description

Attribute Value

Sub-index 00h

Access rw

PDO mapping no

Value range see value definition

Default value 5Fh
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6.1.6 Object 1F81h: NMT Slave Assignment
This object assigns CANopen devices to the NMT master, the device that implements this object. Each sub-index of
this object corresponds to the node-ID of the corresponding CANopen device in the network. The sub-index
corresponding to its own node-ID is ignored. An attempt to change a bit of a functionality that is not supported by
the CANopen device is aborted with code 0609 0030h (invalid value for parameter). The two figures below describe
the structure of the value. The subsequent tables describe the value contents.

The value for the retry factor indicates the number of retries the NMT master issues in case of a node guarding event
(see CiA 301). The value 0 shall disable node guarding for the CANopen device.

The value for the guard time indicates the cycle time for the node guarding of the CANopen device. The value is
indicated in multiples of 1 ms. The value 0 disables node guarding for the CANopen device.

If the heartbeat consumer object is configured to a value unequal 0, then the heartbeat mechanism will have
priority over node guarding.

Object 1F81h – structure of the value

31 24 23 16 15 8 7 0

Guard time Retry factor Configuration

MSB LSB

Object 1F81h – bit structure of the configuration value

7 6 5 4 3 2 1 0

Restore Software
update

Software
version

Reset
communication

Mandatory NMT boot
slave

reserved (0b) NMT slave

MSB LSB

Value NMT slave (bit 0)

Value Description

0b NMT master or not available in the network

1b NMT slave and available in the network

NMT boot slave (bit 2)

Value Description

0b Configuration and NMT service Start remote node shall not be allowed in case of error control
event or NMT service Bootup

Note: The application is responsible for the NMT slave startup

1b Configuration and NMT service Start remote node shall be performed in case of error control
event or NMT service Bootup
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Mandatory (bit 3)

Value Description

0b CANopen device may be present prior to network startup (CANopen device is optional)

1b CANopen device shall be present prior to network startup (CANopen device is mandatory)

Reset communication (bit 4)

Value Description

0b NMT service Reset communication may be executed for the CANopen device at any time

1b NMT service Reset communication shall not be executed for the CANopen device in case the
CANopen device is in NMT state Operational

Software version (bit 5)

Value Description

0b Software version verification shall not be performed for the CANopen device

1b Software version verification shall be performed for the CANopen device

Software update (bit 6)

Value Description

0b Software update shall not be performed for the CANopen device

1b Software update shall be performed for the CANopen device

Restore (bit 7)

Value Description

0b CANopen device may be used without prior resetting

1b CANopen device shall be reset to factory defaults by issuing a restore to defaults (object
1011h)
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Object description

Attribute Value

Index 1F81h

Object name NMT slave assignment

Object code ARRAY

Data type UNSIGNED32

Category optional

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h to 7Fh

Default value 7Fh

Attribute Value

Sub-index 01h

Description Node-ID 1

Entry category conditional
mandatory if node-ID 1 is supported

Access rw

PDO mapping no

Value range see value definition

Default value 0000 0000h

to
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Attribute Value

Sub-index 7Fh

Description Node-ID 127

Entry category conditional
mandatory if node-ID 127 is supported

Access rw

PDO mapping no

Value range see value definition

Default value 0000 0000h
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6.1.7 Object 1F82h: Request NMT
This object allows to request a specific NMT service for a unique CANopen device in the network or for all CANopen
devices in the network in case the CANopen device implementing this object is in NMT master mode. Normally, the
request is issued by another CANopen device in the network or by the application on the very same CANopen device,
for example an IEC 61131 environment.

This object additionally indicates the current NMT state of a unique CANopen device in the network in case the
CANopen device implementing this object is in NMT master mode.

The sub-index corresponds to the node-ID of the CANopen devices in the network. Sub-index 80h addressed all
nodes. Requests may apply for the NMT master itself. The value definition is provided in the table below.

An attempt to download a value that is reserved is responded with abort code 0609 0030h.

The values from 00h to 7Fh have to be applied carefully to not unintentionally affect the NMT master or the

requesting CANopen device itself.

Value definition

Value Description

on upload (read) on download (write)

00h NMT state unknown reserved

01h CANopen device missing reserved

02h reserved

03h reserved

04h NMT state Stopped NMT service Stop remote node
Note that an attempt to request this service for node-ID 0
or the node-ID of the CANopen manager is aborted by the
IXXAT CME/PN to prevent the network from becoming
non-operable.

05h NMT state Operational NMT service Start remote node

06h reserved NMT service Reset node

07h reserved NMT service Reset communication

08h reserved

::: :::

7Eh reserved

7Fh NMT state Pre-operational NMT service Enter pre-operational

80h reserved

::: :::

FFh reserved
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Object description

Attribute Value

Index 1F82h

Name Request NMT

Object code ARRAY

Data type UNSIGNED8

Category optional

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 80h

Default value 80h

Attribute Value

Sub-index 01h

Description Node-ID 1

Entry category conditional

Access rw

PDO mapping no

Value range see value description

Default value 00h

to
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Attribute Value

Sub-index 7Fh

Description Node-ID 127

Entry category conditional

Access rw

PDO mapping no

Value range see value description

Default value 00h

Attribute Value

Sub-index 80h

Description All nodes

Entry category mandatory

Access wo

PDO mapping no

Value range see value description

Default value 00h
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6.1.8 Object 1F84h: Device Type Identification
This object is used for verification of the device type of the CANopen devices in the network. The device type (object
1000h – see CiA 301) of the CANopen device in the network is matched against the value of this object in case the
value is unequal to 0000 0000h. An error event is generated if the values mismatch. The sub-index corresponds to the
node-ID of the CANopen devices in the network. The sub-index corresponding to the own node-ID is ignored.

Object description

Attribute Value

Index 1F84h

Name Device type identification

Object code ARRAY

Data type UNSIGNED32

Category optional

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - 7Fh

Default value 7Fh

Attribute Value

Sub-index 01h

Description Node-ID 1

Entry category conditional
mandatory if node-ID 1 is supported

Access rw

PDO mapping no

Value range see value definition for object 1000h – see CiA 301

Default value 0000 0000h

to
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Attribute Value

Sub-index 7Fh

Description Node-ID 127

Entry category conditional
mandatory if node-ID 127 is supported

Access rw

PDO mapping no

Value range see value definition for object 1000h – see CiA 301

Default value 0000 0000h
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6.1.9 Object 1F85h: Vendor Identification
This object is used for verification of the vendor-ID of the CANopen devices in the network.

The vendor-ID (object 1018h sub-index 01h – see CiA 301) of the CANopen device in the network is matched against
the value of this object in case the value is not equal 0000 0000h. An error event is generated if the values mismatch.

The sub-index corresponds to the node-ID of the CANopen devices in the network. The sub-index corresponding to
its own node-ID is ignored.

Object description

Attribute Value

Index 1F85h

Name Vendor identification

Object code ARRAY

Data type UNSIGNED32

Category optional

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - 7Fh

Default value 7Fh
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Attribute Value

Sub-index 01h

Description Node-ID 1

Entry category conditional
mandatory if node-ID 1 is supported

Access rw

PDO mapping no

Value range see value definition for object 1018h sub-index 01h – see CiA 301

Default value 0000 0000h

to

Attribute Value

Sub-index 7Fh

Description Node-ID 127

Entry category conditional
mandatory if node-ID 127 is supported

Access rw

PDO mapping no

Value range see value definition for object 1018h sub-index 01h – see CiA 301

Default value 0000 0000h
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6.1.10 Object 1F86h: Product Code
This object is used for verification of the product code of the CANopen devices in the network.

The product code (object 1018h sub-index 02h – see CiA 301) of the CANopen device in the network is matched
against the value of this object in case the value is not equal 0000 0000h. An error event is generated if the values
mismatch.

The sub-index corresponds to the node-ID of the CANopen devices in the network. The sub-index corresponding to
its own node-ID is ignored.

Object description

Attribute Value

Index 1F86h

Name Product code

Object code ARRAY

Data type UNSIGNED32

Category optional

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - 7Fh

Default value 7Fh
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Attribute Value

Sub-index 01h

Description Node-ID 1

Entry category conditional
mandatory if node-ID 1 is supported

Access rw

PDO mapping no

Value range see value definition for object 1018h sub-index 02h – see CiA 301

Default value 0000 0000h

to

Attribute Value

Sub-index 7Fh

Description Node-ID 127

Entry category conditional
mandatory if node-ID 127 is supported

Access rw

PDO mapping no

Value range see value definition for object 1018h sub-index 02h – see CiA 301

Default value 0000 0000h
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6.1.11 Object 1F87h: Revision Number
This object is used for verification of the revision number of the CANopen devices in the network.

The revision number (object 1018h sub-index 03h – see CiA 301) of the CANopen device in the network is matched
against the value of this object in case the value is not equal 0000 0000h. An error event is generated if the values
mismatch. A mismatch is defined as

the major revision number is unequal to the expected major revision number, or
the minor revision number is less than the expected minor revision number

The sub-index corresponds to the node-ID of the CANopen devices in the network. The sub-index corresponding to
its own node-ID is ignored.

Object description

Attribute Value

Index 1F87h

Name Revision number

Object code ARRAY

Data type UNSIGNED32

Category optional

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - 7Fh

Default value 7Fh
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Attribute Value

Sub-index 01h

Description Node-ID 1

Entry category conditional
mandatory if node-ID 1 is supported

Access rw

PDO mapping no

Value range see value definition for object 1018h sub-index 03h – see CiA 301

Default value 0000 0000h

to

Attribute Value

Sub-index 7Fh

Description Node-ID 127

Entry category conditional
mandatory if node-ID 127 is supported

Access rw

PDO mapping no

Value range see value definition for object 1018h sub-index 03h – see CiA 301

Default value 0000 0000h
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6.1.12 Object 1F88h: Serial Number
This object is used for verification of the serial number of the CANopen devices in the network.

The serial number (object 1018h sub-index 04h – see CiA 301) of the CANopen device in the network is matched
against the value of this object in case the value is not equal 0000 0000h. An error event is generated if the values
mismatch.

The sub-index corresponds to the node-ID of the CANopen devices in the network. The sub-index corresponding to
its own node-ID is ignored.

Object description

Attribute Value

Index 1F87h

Name Serial number

Object code ARRAY

Data type UNSIGNED32

Category optional

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - 7Fh

Default value 7Fh
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Attribute Value

Sub-index 01h

Description Node-ID 1

Entry category conditional
mandatory if node-ID 1 is supported

Access rw

PDO mapping no

Value range see value definition for object 1018h sub-index 04h – see CiA 301

Default value 0000 0000h

to

Attribute Value

Sub-index 7Fh

Description Node-ID 127

Entry category conditional
mandatory if node-ID 127 is supported

Access rw

PDO mapping no

Value range see value definition for object 1018h sub-index 04h – see CiA 301

Default value 0000 0000h
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6.1.13 Object 1F89h: Boot Time
The object defines the time out between start of the process Start process boot NMT slave and the signaling of the
successful boot of all mandatory NMT slaves. The value is given in multiples of 1 ms. The value 0000 0000h disables
the timer.

Object description

Attribute Value

Index 1F89h

Object name Boot time

Object code VAR

Data type UNSINGED32

Category optional

Entry description

Attribute Value

Sub-index 00h

Access rw

PDO mapping no

Value range UNSIGNED32

Default value 0000 0000h
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6.2 Manufacturer Specific Objects
IXXAT CME/PN implements manufacturer specific objects to enable access to additional configuration options and to
diagnostics and status information. These objects are described below:

Process Image Byte Order Configuration
General CANopen Diagnostics Objects
CANopen Network Diagnostics Object
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6.2.1
Object 4000h: Process Image Byte Order
Configuration

This object allows to configure the byte order representation of the process image on IXXAT CME/PN to be
either little endian (the network byte order for CANopen networks) or big endian format (the default network byte
order for PROFINET networks). The default is big endian format, enabling the user to work with process data in the
default byte order for PROFINET systems. The object is only accessible from CANopen Configuration Studio for IXXAT
CME/PN. The parameterized value is included in the concise device configuration file that is downloaded into the
IXXAT CME/PN gateway. Any attempt to write this object from the CANopen network is aborted with error code 0800
0021h: Data cannot be transferred or stored to the application because of local control.

Value definition Process Image Endianness Configuration

Value Description

00h Process data of IXXAT CME/PN represented in little endian format

01h Process data of IXXAT CME/PN represented in big endian format

Object description

Attribute Value

Index 4000h

Name Process Image Byte Order Configuration

Object code VAR

Data type UNSIGNED8

Category Manufacturer specific

Entry description

Attribute Value

Sub-index 00h

Access rw

PDO mapping no

Value range see value definition

Default value 01h
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6.2.2 General CANopen Diagnostics Objects
The IXXAT CME/PN gateway implements manufacturer specific diagnostic objects that enable the user to identify a
failed remote CANopen device and to read the corresponding error information. You can access the diagnostic
objects via PROFINET using a PLC program.

The supported diagnostic objects are listed in the table below:

Index Sub-index Name Type Description

5000h Status CANopen manager RECORD

00h Highest sub-index supported UNSIGNED8

01h Event indication UNSIGNED16 Equal to object 5020h byte 4 and 5

00h = OK

02h State of the CANopen manager UNSIGNED8 High nibble

00h INIT

40h MASTER_STATE_RESET

60h PREPARE_NET_INIT

61h NTW_RESET

62h NTW_WAIT

64h BOOT_CONF

70h BOOT_END_MISSING_MAND

8xh CLEAR

Axh RUN

Cxh STOP

Exh PREOPERATIONAL

90h FATAL_ERROR

Low nibble

Bit
0

0 No error

1 At least one optional or
unexpected CANopen
module does not
correspond to the
expected network
configuration

Bit
1

0 No error

1 At least one mandatory
CANopen module does
not correspond to the
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expected network
configuration

Bit
2

0 No CANopen device,
including the CANopen
manager is in NMT state
Operational

1 At least one CANopen
device is in NMT state
Operational (not including
the CANopen manager)

Bit
3

0 The CANopen manager is
not in NMT state
Operational

1 The CANopen manager is
in NMT state Operational

03h Communication status of the
CANopen manager

UNSIGNED8 0 = OK
10h = OK, if CANopen diagnostic

device is “Tx passive”

5001h Assigned slaves bit list ARRAY Bit flag list of CANopen slave
devices for which bit 0 in object
1F81h is set to 1. Device with this

configuration are assigned to the
CANopen manager and present in
the network

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5002h Configured slaves bit list ARRAY Bit flag list of CANopen devices for
which the boot slave process has
been successfully completed and
which are fully configured based
on the concise DCF data for the
particular device

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

Index Sub-index Name Type Description
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04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5003h Fault slaves bit list ARRAY Bit list that flags all attached
CANopen slave devices for which
an error has been detected.
Errors reasons may include:

CANopen devices that were
detected in the CANopen
network, but are not
declared in object 1F81h

CANopen devices that reuse
the CANopen node-ID used
by the CANopen manager
itself

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5004h Operational slaves bit list ARRAY Bit flag list of CANopen slave
devices with expected NMT state
Operational. The bit list is
populated based on NMT node
control commands issued by the
CANopen manager. The
operational slave bit list is not
directly synchronized with
information from NMT error
control services (heartbeat or node
guarding). On error control events
such as heartbeat or node
guarding errors, or on detected
boot-up messages, the bit flag for
the particular CANopen slave is
cleared

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

Index Sub-index Name Type Description
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04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5005h Stopped slaves bit list ARRAY Bit flag list of CANopen slave
devices with expected NMT state
Stopped. The bit list is populated
based on NMT node control
commands issued by the CANopen
manager. The stopped slave bit list
is not directly synchronized with
information from NMT error
control services (heartbeat or node
guarding). On error control events
such as heartbeat or node
guarding errors, or on detected
boot-up messages, the bit flag for
the particular CANopen slave is
cleared.

Devices that have been detected in
the network but are not declared
as CANopen slave devices assigned
to the CANopen manager will be
set into NMT state Pre-operational
by default to prevent network
disruption. The application may set
these devices alternatively into
NMT state Stopped. The bit flag for
these devices is then set to 1 in the
stopped slaves bit list.

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5006h Pre-operational slaves bit list ARRAY Bit flag list of CANopen slave
devices with expected NMT state
Pre-operational. The bit list is
populated based on NMT node
control commands issued by the
CANopen manager. The pre-
operational slave bit list is not
directly synchronized with
information from NMT error
control services (heartbeat or node
guarding). On error control events

Index Sub-index Name Type Description
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such as heartbeat or node
guarding errors, or on detected
boot-up messages, the bit flag for
the particular CANopen slave is
cleared.

Devices that have been detected in
the network but are not declared
as CANopen slave devices assigned
to the CANopen manager will be
set into NMT state Pre-operational
by default to prevent network
disruption. The bit flag for these
devices is set to 1 in the pre-
operational slaves bit list.

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5007h Emergency slaves bit list ARRAY Slave has transmitted at least one
emergency message, the
corresponding device is not error
free

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5008h Inconsistent concise DCF bit list ARRAY Bit flag list of CANopen slave
devices for which a format error
has been detected in the concise
DCF data containing the
configuration information for the
slave device

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

Index Sub-index Name Type Description
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03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5009h Mismatching concise DCF bit list ARRAY Bit flag list of CANopen devices for
which the internal structure in the
concise DCF data does not
correspond to the object dictionary
layout of the connected CANopen
slave device. This case is detected if
the download of configuration data
to the CANopen slave device is
terminated by means of a SDO
abort protocol

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

500Ah Identity error bit list ARRAY Bit flag list of CANopen slave
devices for which the identity
information in the arrays 1F84h to

1F88h does not correspond to the

identity information retrieved from
objects 1000h and 1018h, sub-

index 01h to 04h of the CANopen

slave device

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h - 20h UNSIGNED32 Bit n represents node-ID (n+1)

02h Node-ID 21h - 40h UNSIGNED32 Bit n represents node-ID (n+33)

03h Node-ID 41h - 60h UNSIGNED32 Bit n represents node-ID (n+65)

04h Node-ID 61h - 7Fh UNSIGNED32 Bit n represents node-ID (n+97). Bit
31 is always 0

5010h Node error count ARRAY The CANopen manager counts the
emergency messages received
from each of the CANopen slave
devices starting with the NMT
startup process. Emergency
messages indicating an error free
condition are counted as well. If

Index Sub-index Name Type Description
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the counter has reached the limit
of 255, the counter is not
incremented further.

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h UNSIGNED8 Emergency counter for node-ID
01h

::

7Fh Node-ID 7Fh UNSIGNED8 Emergency counter for node-ID
7Fh

5011h 00h Generic error count UNSIGNED8 The CANopen manager counts and
categorizes emergency messages
received from any CANopen slave
according to the most important
error types. If a counter has
reached the value 255, it is not
incremented further.

Error code 10xxh

5012h 00h Device hardware error count UNSIGNED8 see description for object 5011h

Error code 50xxh

5013h 00h Device software error count UNSIGNED8 see description for object 5011h

Error code 60xxh

5014h 00h Communication error count UNSIGNED8 see description for object 5011h

Error code 81xxh

5015h 00h Protocol error count UNSIGNED8 see description for object 5011h

Error code 82xxh

5016h 00h External error count UNSIGNED8 see description for object 5011h

Error code 90xxh

5017h 00h Device specific error count UNSIGNED8 see description for object 5011h

Error code FFxxh

5018h CANopen slave emergency history ARRAY If no emergency message has yet
been received by a CANopen slave
that is part of the CANopen
network, byte 0 returns the value
zero. The size of the domain is one.

Else the value of byte 0 specifies
the number of the last emergency
message received.

Index Sub-index Name Type Description
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The data of the emergency
messages are copied into the
queue in the same order as they
were received (LSB first). Every
emergency message consists of
exactly 8 bytes.

00h Highest sub-index supported UNSIGNED8

01h Node-ID 01h DOMAIN Emergency history for node-ID 01h

::

7Fh Node-ID 7Fh DOMAIN Emergency history for node-ID 7Fh

5020h 00h CANopen network diagnostics UNSIGNED48 see CANopen network diagnostics
object description

5030h Fatal error log RECORD

00h Highest sub-index supported UNSIGNED8

01h Number of fatal errors UNSIGNED16

02h Fatal error log DOMAIN Contact Technical Support for
details

Index Sub-index Name Type Description
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6.2.3 Object 5020h: CANopen Network Diagnostics Object
General summary of state of CANopen manager, CANopen slave devices, and the CAN network.

Value definition CANopen network diagnostics

Byte(s) number Name Description

0 CANopen manager
state machine

Value coded:

0. Waiting for CANopen initialization or CANopen initialization is
running

1. IXXAT CME/PN is configured as CANopen slave

Only valid if IXXAT CME/PN is configured as NMT master
2. Process NMT startup has not been started
3. Process NMT startup in state reset network
4. Process NMT startup scanning the network and booting the

CANopen slave devices
5. Reserved, always 0
6. Reserved, always 0
7. Process NMT startup mandatory slave error: boot time not

elapsed
8. Process NMT startup: CANopen manager is allowed to start itself

and the network
9. Process NMT startup: CANopen manager is allowed to start itself

but not the network
10. Process NMT startup: CANopen manager is not allowed to start

itself but may start the network
11. Process NMT startup: CANopen manager is neither allowed to

start itself nor the network
12. Process NMT startup finished: CANopen manager is allowed to

start a booted slave autonomously
13. Process NMT startup finished: CANopen manager is allowed to

start a booted slave if the CANopen manager is in NMT state
Operational

14. Process NMT startup finished: CANopen manager is not allowed
to start a booted slave autonomously

Fatal error
15. Severe software error has been detected

1 CANopen state of
the CANopen
manager

Value coded:

0. NMT state Operational
1. NMT state Stopped
2. NMT state Pre-operational
3. Waiting for initialization or CANopen initialization is running
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Value definition CANopen network diagnostics

Byte(s) number Name Description

2 CAN status Bit coded:

0. Bus off
1. CAN receive message lost
2. CAN transmit message
3. Warning level reached
4. Transition warning level reached to warning level left occurred
5. Cable break

3 CANopen
slave status

Bit coded:

0. Mandatory slave missing, identity error, or concise DCF error
1. Optional slave missing, identity error, concise DCF error, or unexpected

device(s) present in the network
2. At least one operational slave that has been booted successfully
3. At least one pre-operational slave that has been booted successfully
4. At least one stopped slave that has been booted successfully

4 - 5 Event
indication

Byte 4, bit coded:

0. Fatal error
1. Another device uses the node id of the CANopen manager
2. Error control event of a mandatory slave
3. Identity error of a mandatory slave
4. Identity error of an optional slave
5. No communication with the PROFINET IO controller
6. Communication status with the PROFINET IO controller has changed
7. General indication: network management event

Byte 5, bit coded:

0. NMT slave assignment configuration error
1. Reception of a RPDO with less data than expected
2. Mismatching concise DCF
3. Inconsistent concise DCF
4. Failed save configuration
5. Cable break detected
6. The state of the CANopen network has been changed by a request NMT

command (see object 1F82h) via a CAN message

7. The state of a single CANopen slave has been changed by request NMT
command (see object 1F82h) via a CAN message
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Object description

Attribute Value

Index 5020h

Name CANopen network diagnostics

Object code VAR

Data type UNSIGNED48

Category Manufacturer specific

Entry description

Attribute Value

Sub-index 00h

Access ro

PDO mapping no

Value range see value definition

Default value no
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6.3 Device Profile Objects
The configuration examples discussed in earlier sections are based on generic device description files according to CiA
401 CANopen device profile for generic I/O modules. The objects used in those example configurations are:

Index Object type Name Data type CiA specification

6000h ARRAY Read input 8 bit UNSIGNED8 CiA 401

6200h ARRAY Write output 8 bit UNSIGNED8 CiA 401

6401h ARRAY Read analog input 16 bit INTEGER16 CiA 401

6411h ARRAY Write analog output 16 bit INTEGER16 CiA 401
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6.3.1 Object 6000h: Read Input 8 bit
This object reads groups of 8 input lines as 8 bit information. The object is mandatory for digital input modules.

Object description

Attribute Value

Index 6000h

Object name Read input 8 bit

Object code ARRAY

Data type UNSINGED8

Category conditional
mandatory if the device supports digital inputs

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - FEh

Default value Device specific

Attribute Value

Sub-index 01h

Description Read input 01h to 08h

Entry category mandatory

Access ro

PDO mapping TPDO

Value range UNSIGNED8

Default value no

to
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Attribute Value

Sub-index FEh

Description Read input 7E8h to 7F0h

Entry category optional

Access ro

PDO mapping TPDO

Value range UNSIGNED8

Default value no
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6.3.2 Object 6200h: Write Output 8 bit
This object sets groups of 8 output lines as 8 bit information. The object is mandatory for digital output modules.

Object description

Attribute Value

Index 6200h

Object name Write output 8 bit

Object code ARRAY

Data type UNSINGED8

Category conditional
mandatory if the device supports digital outputs

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - FEh

Default value Device specific

Attribute Value

Sub-index 01h

Description Write output 01h to 08h

Entry category mandatory

Access rw

PDO mapping RPDO

Value range UNSIGNED8

Default value 00h

to
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Attribute Value

Sub-index FEh

Description Write output 7E8h to 7F0h

Entry category optional

Access rw

PDO mapping RPDO

Value range UNSIGNED8

Default value 00h
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6.3.3 Object 6401h: Read Analog Input 16 bit
This object reads the value of one input channel per sub-index. The object is mandatory for analog input modules.

Object description

Attribute Value

Index 6401h

Object name Read analog input 16 bit

Object code ARRAY

Data type INTEGER16

Category conditional
mandatory if the device supports analog inputs

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - FEh

Default value Device specific

Attribute Value

Sub-index 01h

Description Analog input 01h

Entry category mandatory

Access ro

PDO mapping TPDO

Value range INTEGER16

Default value no

to
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Attribute Value

Sub-index FEh

Description Analog input FEh

Entry category optional

Access ro

PDO mapping TPDO

Value range INTEGER16

Default value no

CANopen Configuration Studio for IXXAT CME/PN 163

©2015 IXXAT Automation GmbH. All Rights Reserved.



6.3.4 Object 6411h: Write Analog Output 16 bit
This object writes an unsigned 16 bit value to an analog output channel. The object is mandatory for analog output
modules.

Object description

Attribute Value

Index 6411h

Object name Write analog output 16 bit

Object code ARRAY

Data type INTEGER16

Category conditional
mandatory if the device supports analog outputs

Entry description

Attribute Value

Sub-index 00h

Description Highest sub-index supported

Entry category mandatory

Access const

PDO mapping no

Value range 01h - FEh

Default value Device specific

Attribute Value

Sub-index 01h

Description Analog output 01h

Entry category mandatory

Access rw

PDO mapping RPDO

Value range INTEGER16

Default value 0000h

to
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Attribute Value

Sub-index FEh

Description Analog output FEh

Entry category optional

Access rw

PDO mapping RPDO

Value range INTEGER16

Default value 0000h
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7     Glossary 

C
CAN
Controller Area Network

CAN-ID
CAN identifier

CiA
CAN in Automation e.V.

COB
Communication Object

COB-ID
COB identifier

Concise DCF
Concise DCF. Specified in CiA 302-3

D
DCF
Device Configuration File. Specified in CiA 306

E
EDS
Electronic Data Sheet
Electronic device description format as specified in CiA 306

F
FSA
Finite state automaton

G
GSD
General Station Description

GSDML 
General station description markup language. XML based markup language to describe PROFINET
devices. Specified in PNO Order No: 2.352

L
LSB
Least significant bit/byte

M
MPDO
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Multiplexed-PDO

MSB
Most significant bit/byte

N
NMT
Network Management

NMT error control
Node guarding, heartbeat

NMT node control

Node-ID
Unique node identifier with a valid range from 1 to 127.

P
PDO
Process Data Object

PLC 
Programmable Logic Controller

Process data duration
Time interval for which process data retain their current values

PROFINET Update Time
The update time is the time interval within which an IO device in the PROFINET IO system is supplied
cyclically with new data from the IO controller. The update time may be configured separately for each
IO device and determines the interval at which data is sent from the IO controller to the IO device
(output module) as well as from the IO device to the IO controller (input module).

R
RPDO 
Receive PDO

S
SDO 
Service Data Object

SYNC
Synchronization object

T
TPDO 
Transmit PDO
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9 Support Addresses
 

Support:

Sweden (HQ)
Tel : +46 35 17 29 20
E-mail: support@hms-networks.com

France
Tel: +33 3 89 32 76 41
E-mail: fr-support@hms-networks.com

Italy
Tel: +39 039 59662 27
E-mail: it-support@hms-networks.com

North America
Tel: +1 312 829 0601
E-mail: us-support@hms-networks.com

China
Tel: +86 10 8532 3023
E-mail: cn-support@hms-networks.com

Germany
Tel: +49 721 989777-300
E-mail: ge-support@hms-networks.com

Japan
Tel: +81 45 478 5340
E-mail: jp-support@hms-networks.com

Denmark
Tel: +46 35 17 29 20
E-mail: support@hms-networks.com

India
Tel: +91 20 40111201
E-mail: in-support@hms-networks.com

UK & Eire
Tel: +46 35 17 29 20
E-mail: support@hms-networks.com

HMS Industrial Networks is a world leading supplier of industrial network technology. HMS develops and manufactures products used for interfacing

automation devices to industrial networks. SIMATIC® is a registered trademark of Siemens AG. S7™ and STEP 7™ are trademarks of Siemens AG.

Part No: 4.02.0159.20010 Version 2.1 - HMS reserves the right to make modifications without prior notice.
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